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About this Guide

This introduction provides a brief overview of the Polycom Digital Signage 
Administrator Guide, describes the conventions used in this manual, and 
explains how to get additional information or support.

Purpose
The Polycom Digital Signage Administrator Guide describes how to configure 
and use the Polycom Digital Signage Player and Remote Manager for a 
complete digital signage solution.

Documentation 
The Polycom Digital Signage Administrator Guide is part of the Polycom Digital 
Signage documentation set, which includes:

• Polycom Digital Signage Administrator Guide - This document.

• Polycom Digital Signage Server Getting Started Guide - Describes set-up and 
installation of the Polycom Digital Signage Server.

• Polycom Digital Signage Player Getting Started Guide - Describes set-up and 
installation of the Polycom Digital Signage Player.

• Polycom Digital Signage Content Management Guide - Describes publication 
of content via the Polycom Digital Signage Web Controller. This document 
is intended for Polycom Digital Signage Content Managers.

• Polycom Digital Signage Release Notes - Describes the product release. This 
document also identifies known problems and their workarounds, 
information not covered in the manuals or that has been modified since 
publication, as well as problems that have been fixed since previous 
releases.
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Audience
This guide is primarily for:

• Polycom Digital Signage Administrators - Responsible for configuring 
and managing the Polycom appliance. You should have a working 
knowledge of media publication, peripheral ports, network protocols, and 
media streaming and editing. You should also be familiar with Web 
fundamentals, such as URLs and HTML.

Customer Support
Recognizing that technology alone cannot solve today’s complex challenges, 
Polycom Global Services provides the industry’s best technical support staff 
and programs to let you concentrate on the task at hand. Polycom users can 
select from a variety of support solutions to obtain the level of support that 
best meets their needs.

Before contacting your Polycom Global Services representative for technical 
assistance, gather as much information as possible about your situation. Any 
information you can provide helps us assess the problem and develop an 
appropriate solution.

Polycom Global Services Telephone
If you have comments or questions about Polycom or if you need technical 
assistance, contact:

• Polycom Global Services in U.S.A. 888-248-4143
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About Polycom Digital Signage

This chapter explains the Polycom Digital Signage architecture. This chapter 
includes the following sections:

• Polycom Digital Signage Solution

• Architecture Overview

Polycom Digital Signage Solution
The Polycom Digital Signage solution is a combination of powerful 
applications, including the following components: 

Polycom Digital Signage Player
The Polycom Digital Signage Player is a powerful broadcast rendering engine 
that delivers the highest quality output with the highest level of reliability. 
Unlike simple video playback devices, the Polycom Digital Signage Player 
dynamically arranges and composes signage elements, objects or zones in real 
time to generate the final video output. This means individual content 
elements can be changed at any time, without requiring entire video segments 
to be re-rendered whenever a change is needed.

Polycom Digital Signage Server
The Polycom Digital Signage Server automatically distributes new content to 
remote locations and receives continuous status updates from all Polycom 
Digital Signage Players. 

Polycom Digital Signage Remote Manager 
The Polycom Digital Signage Remote Manager application works with the 
Polycom Digital Signage Server to enable administration of networks of 
players.

Download from Www.Somanuals.com. All Manuals Search And Download.



Polycom Digital Signage Administrator Guide Architecture Overview

2 Polycom, Inc.

  

Polycom Digital Signage Web Controller 
The Polycom Digital Signage Web Controller software lets users easily update 
and manage content on the Players in a Polycom Digital Signage network, 
with point-and-click simplicity.

Polycom Digital Signage Agent
The Polycom Digital Signage Agent software is the link between Players and 
the Server, enabling network status and health monitoring.

Architecture Overview

The image above presents an overview of the Polycom Digital Signage 
solution, depicting the overarching architecture for the various components of 
the solution. Content, in the form of templates, assets, and playlists, is created, 
assembled and managed using the Polycom Digital Signage Web Controller. 
Users can easily update content using the Web Controller’s point-and-click 
interface. 

The content is automatically distributed to Polycom Digital Signage Players 
via the Polycom Digital Signage Server, which acts as the central hub for the 
Polycom Digital Signage system. 

The Polycom Digital Signage Player renders content in real time for display to 
a monitor, with the Polycom Digital Signage Agent linking Players to the 
Server. The Polycom Digital Signage Agent also monitors the status of the 
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Polycom Digital Signage Player, and sends regular heartbeat and status 
messages to the Polycom Digital Signage Server. The Agent can also take steps 
to "heal" the Player if it detects a problem.

Administrators monitor and manage the system using the Polycom Digital 
Signage Remote Manager application. This software displays the status and 
details of all the Players connected to the system. 

Administrators can also use the Polycom Digital Signage Remote Manager to 
distribute and manage content packages, as well as issue commands to 
individual players or groups of players, although content updates and 
distribution are typically handled via the Polycom Digital Signage Web 
Controller.

The Web Controller is used for day-to-day updates to content appearing on the 
monitors in a given Polycom Digital Signage network.
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1
Configuring the PDS Player

This chapter explains the basic configuration processes for the Polycom Digital 
Signage Player. This chapter includes the following sections:

• About the PDS Player

• Accessing the Player

• Configuring the Player Directly

• Configuring PDS Player Video Settings

• Startup Settings

• Options

• Configuring PDS Player Advanced Settings

About the PDS Player
The PDS Player is a powerful real-time broadcast rendering engine that 
delivers the highest quality output with the highest level of reliability. It offers 
reliable playback for 24x7 operation.

Unlike simple video playback devices, the PDS Player dynamically arranges 
slide elements in real time to generate the final video output. This means 
individual elements of the content can be changed at any time, without 
requiring that entire video segments be re-rendered whenever a change is 
required.

Accessing the Player
After installation, the PDS Player can be configured directly or through 
Windows Remote Desktop Protocol (RDP). 
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If using RDP to access a Player, you will not be prompted to enter login 
credentials. Please note, however, that to reboot a PDS Player using RDP you 
will need to enter ALT + F4. This will launch a shut down dialog, from which 
you must select Restart.

Configuring the Player Directly
After a Player has been set up, connected to an output, and connected to the 
network via the Polycom Digital Signage Agent, administrators can configure 
the Player for their particular implementation. The following sections outline 
the various configuration possibilities. Please note that the following process 
applies for all configuration changes:

1 Launch the PDS Player from the desktop, if it is not already running.

2 Stop Player output by hitting ALT + ESC, if necessary.

3 Navigate to Tools > Settings. The Settings window will appear.

4 Choose which tab in the Settings window you wish to edit. The specifics 
of each tab are detailed below.

5 When configuration has been completed, click Apply and then OK.

6 Reload the Playlist in the Player.

Configuring PDS Player Video Settings
PDS Player Video Settings is divided into two sections: Output Window and 
Capture Settings. 

Settings defined in Output Window let you configure the properties of the 
PDS Player output window on the Player output display.

Settings defined in Capture Settings let you configure how the PDS Player 
communicates with 3rd-party capture devices.

NOTE: Accessing the Player via RDP locks the Player output. As a result, RDP is 
not a recommended tool for routine player management. If you wish to make 
content and configuration changes while the Player is running, use the Polycom 
Remote Manager and Polycom Web Controller. 
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Output Windows Settings
The Output Window section of Video Settings includes the following 
configuration options:

• Standard: Specifies the dimensions of the video output window. Choose 
from a list of standard resolutions: 640x480, 720x480 (DV-NTSC), 720x486 
(NTSC SMPTE), 720x576 (PAL), 800x600, 1024x768, 1280x720, 1280x1024, 
1600x1200, and 1920x1080.

• Custom: Specifies the dimensions of the video output window according 
to the specified Width (W) and Height (H).

• Orientation: Specifies whether the video output window should be 
displayed in either Landscape or Portrait format, in conjunction with the 
Standard or Custom output window dimensions.

• Auto size output to match slide dims: When selected, the resolution of the 
video output window will scale to match the slide template dimensions.

• Auto size slide to match output: When selected, the resolution of the slide 
template is automatically scaled to match the resolution of the video 
output window.

• Dual monitor mode: When selected, configures the PDS Player display 
output to appear on a second monitor. This mode can also be used for 
cloning the display. This supports multiuple monitors from one Player. 
See the Polycom Digital Signage Player Getting Started Guide for more details.
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• Full screen: When selected, the PDS Player output will be displayed in full 
screen mode (either on the primary or secondary display). When 
unselected, the PDS Player output will be displayed in a separate window.

• Output Window Zoom: Select to resize the CG Rendering window to 
100% (full size) or 50% half size when the Full screen mode is disabled.

• Wait on VSync: Depending on the features and the performance of your 
system's graphics card adapter, select one of the following options:

— True: Significant loss of system performance with a high-quality 
graphics output result. 

— Hybrid: Improved system performance with some loss in the quality 
of the graphics output result.

— False: Best possible performance with a low-quality graphics output 
result.

Capture Settings
Capture Settings determine how video and audio are interpreted for input to 
the PDS Player.

• Video Capture Filter: Select the device for inputting video to the PDS 
Player. This list depends on the video devices connected to the 
workstation.

• Video Crossbar Setting: Select the port for the video input to the 
workstation, for example SVideo In or Composite In.

• Audio Capture Filter: Select the device for inputting audio. This list 
depends on the audio card and audio devices connected to the 
workstation, for example SoundMAX Digital Audio.

• Audio Crossbar Setting: Select the port for the audio input to the 
workstation.

• TV Tuner Channel: Select the channel to tune to when capturing from a 
TV Tuner card. Select channel 0 if no TV Tuner card is present.

Startup Settings
The PDS Player Startup Settings tab is divided into two sections: Startup 
Properties and Startup Options. 

NOTE: Only custom implementations support changes to capture settings.
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Settings defined in Startup Properties let you specify templates or scripts that 
may load when PDS Player initially launches, as well as application functions 
that may occur when PDS Player initially launches.

Startup Properties
The Startup Properties settings of Startup Settings are described as follows:

• Default Background Template: Specifies a template to load by default in 
the background layer of the CG output when the PDS Player first 
launches.

• Default Foreground Template: Specifies a template to load by default in 
the foreground layer of the CG output when the PDS Player first launches.

• Startup Image Filename: Specifies an image to load in the CG output 
when PDS Player first launches.

• Startup Script Filename: Specifies a script to execute when the PDS Player 
first launches.

Startup Options
The Startup Options settings of Startup Settings are described as follows:
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• Load previously loaded playlist on startup: When enabled, loads the 
previously loaded playlist when the PDS Player launches. When disabled, 
the PDS Player launches remaining in a ready state with no content 
displayed on the CG output.

• Minimize on startup: When enabled, hides the PDS Player interface from 
the system desktop.

• Auto launch renderer on startup: When enabled, automatically launches 
the CG rendering engine.

Options
The PDS Player Options tab is divided into three sections: General, Messages, 
and Audio Settings. Settings defined in General let you specify options 
available to the PDS Player. Settings defined in Messages let you specify 
options related to the Messages window. Settings defined in Audio Settings let 
you specify options related audio output from the PDS Player.

TIP: Enable Load previously loaded playlist on startup to automatically resume 
playback of your content on-air and recover from system anomalies or power 
failures
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General
The General Settings panel allows administrators to dictate certain general 
configuration settings for the CG Rendering engine that is launched by default 
from the PDS Player. The settings are described as follows:

• Show renderer control panel: When enabled, displays the CG rendering 
engine control panel.

• Enable auto screenshot: When enabled, takes screenshots of the content 
being displayed by the PDS Player. These screenshots are then displayed 
in the “Current Output Window” section of the PDS Player.

• Close renderer on exit: When enabled, closes the CG rendering engine 
when the PDS Player quits.

• Prerender next slide in presentation: When enabled, stores the next event 
in system memory while the current event is displayed on the output.

• Restrict cursor to primary display: When enabled, prevents the system 
mouse cursor from appearing on the secondary output of the the PDS 
Player.

Messages
The Messages Settings panel is described as follows:

• Show Messages Box: The Messages dialog in the PDS Player interface 
provides moment-by-moment details regarding functioning of the PDS 
Player. The frequency of messages can be determined in the Show 
Messages Box. Select one of the following options:

— On Error: Displays messages in the Messages dialog only when an 
error has occurred.

— Always: Displays all messages-errors, information, status-in the 
Messages dialog.

— On Request Only: Displays messages only upon request when you 
click the Show Messages button in the PDS Player.

— Log All Messages: Writes all PDS Player events to the log file.

• Message Filter Box: Select one of the following options:

— Show Critical Messages Only: Displays messages in the Messages 
dialog only when an error has occurred. 

— Show All Messages: Displays messages only when you click the 
Show Messages button in the Settings dialog. Messages displayed 
include content updates, configuration changes, output changes, and 
updates to data-driven templates, as well as error messages displayed 
in red text.
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Audio
The Audio Settings of the Options window are described as follows:

• Adjust volume on slide load: When enabled, increases or decreases the 
audio output level based on the number configured in the Player Default 
Volume.

• Use Default Volume From Box: Select one of the following options:

— System Volume: the PDS Player will output audio based on the 
volume of the system's mixer settings

— PDS Setting: the PDS Player will output audio based on the default 
volume specified.

• PDS Default Volume: Audio level (from 0 - 100) to use for audio output.

Configuring PDS Player Advanced Settings 
The PDS Player Advanced Settings tab allows users to change system defaults. 
These settings should not be changed without consulting Polycom Support.

The PDS Player Advanced tab is divided into three sections: Renderer 
Settings, File Locations, and Playout Settings.

NOTE: Please avoid modifying these values unless instructed to do so by Polycom 
support.
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Renderer Settings
The Renderer Settings options of Advanced Program Settings are described as 
follows:

• Renderer IP Address: Displays the IP address of the rendering engine. 

• Renderer Executable Filename: Displays the executable filename that 
corresponds to the PDS rendering engine. 

• Connection Delay: Displays the delay, in seconds, from the time you click 
the Render button until the scene is submitted CG rendering engine. 

File Locations
The File Locations configuration in Advanced Program Settings allow users to 
dictate which directories the PDS Player uses:

• Output folder: Displays the folder to which the CG Renderer sends 
rendered output that is displayed in the output monitor. 

• Cache folder: Displays the folder to which the CG Renderer caches 
information while rendering the output. 

• Template folder: Displays the default folder to which the PDS Player 
saves exported templates. 
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• Command folder: Displays the folder to which the commands are stored 
on the system for use with other PDS applications such as Remote 
Manager, or Web Screens. 

Playout Settings
The Playout Settings of the Advanced Program Settings are as follows:

• Player Mode box:

— Standard: Configures the PDS Player to function as an authoring 
station.

— Interactive: Configures the PDS Player to function as an 
interactive/kiosk station. 

• Interactive Window: When in Interactive Player Mode, defines the 
topmost and leftmost location (XPos/YPos) and size (Width/Height), in 
pixels, of the interactive window.

• URL Loader Window: When displaying an internet browser window, 
defines the topmost and leftmost location (XPos/YPos) in pixels, of the 
Loader window.

NOTE: Interactive mode is not supported in most implementations. Please do not 
select this option without input from Polycom support.
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2
Using the PDS Player

This chapter outlines local control of the Polycom Digital Signage Player. In a 
typical implementation, however, all configuration and content management 
will be performed through the PDS Remote Manager and PDS Web Controller. 
Please note that these tools are described in subsequent chapters.

This chapter includes the following sections:

• Getting Started

• The PDS Player Interface

• Scheduling Events with the PDS Player

• Controlling the VertigoCG Renderer

Getting Started
When the PDS Player application is opened, it will immediately begin 
displaying the default playlist.

Loading a Template
1 To load a PDS Template, in the PDS Player choose File > Load 

Template…

2 Locate a PDS Template (.xtmpl) on your computer and choose Open.

The template plays in the PDS Player output.
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3 If you have elected not to use full-screen mode, the content will be 
displayed on the CG Rendering Window. To disable the CG Rendering 
Window, open Tools > VertigoCG and select Stop. Alternatively, press 
ALT + ESC. 

Further controls for the CG Renderer are detailed below. 

Loading a Playlist
1 To load a PDS Playlist, in the PDS Player choose File > Load Playlist…

2 Browse to a PDS Playlist (.xplst) on your computer and choose Open.

The playlist plays in the CG Rendering window. 

3 To playback a PowerPoint slide in the PDS Player, with a PowerPoint 
presentation loaded, select a slide and choose Tools > Render 
PowerPoint Slide.

The slide plays in the CG Rendering window.
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The PDS Player Interface
The PDS Player is designed to facilitate the task of playing out either 
individual templates, playlists, or creating schedules of events.

Current Playlist
Displays the directory path and name of the currently active playlist. 

Default Layer 

NOTE: Previously loaded playlists can be quickly loaded by clicking on the Current 
Playlist filename bar and choosing a playlist from the drop-down list that appears.
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Specifies the rendering layer in which a template loads. Options available 
are Background and Foreground. 

Default Transition

Specifies the default transition effect to be used in between templates 
loaded in a playlist. Transitions from which you can select include Cut, 
Fade, Crossfade, Push Right, Push Left, and Random.

Events

• Last Event: The time of the last event loaded or executed in the Player.

• Next Event: The time of the next planned event to occur in the Player.

• Time to Next Event: Countdown timer of the next planned event to occur 
in the Player.

Control Buttons

• Load: Opens a dialog box to load templates or playlist files.

• Clear: Removes the contents of a previously loaded playlist from the 
Player.

• Reset All: Clears the output of the CG rendering window.

Playlist Controls
The PDS playlist controls are described as follows:
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:

Message Control

• When Show Messages is enabled, displays messages from the PDS Player. 
The Clear button clears the contents of the Messages window.

Current Output Window

• When Enable Auto Screenshot is enabled, displays a preview of the 
current output of the PDS Player.

Button Function

Pauses the playback of the currently loaded playlist.

When paused, resumes playback of the currently loaded 
playlist.

Plays the previous event in the currently loaded playlist.

Plays the next event in the currently loaded playlist. 

Jumps to the first event in the currently loaded playlist. 

Jumps to the last event in the currently loaded playlist.
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Scheduling Events with the PDS Player
With the PDS Scheduler, you can create playout schedules for several different 
playlists, or assign PDS commands to occur at specific times throughout the 
day. 

Schedules can also include control events, such as starting a crawling ticker on 
the output screen. This allows users in the central location to schedule any 
kind of control event by assigning the appropriate event in the schedule.

To activate PDS Scheduler:

1 In the PDS Player, choose Tools > Schedule…. The PDS Scheduler 
window appears.
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2 If the Schedule is presented by Month rather than Day, go to the View 
Mode box and select Day.

3 In the Day view, right-click on the date and time at which to start playing 
the slideshow. From the Scheduler menu that appears, select Add 
Event…. The Add Schedule Event dialog appears.
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4 In the Event box, select Load Presentation.

You can also select any of the following and schedule its playout:

Load Presentation: Schedules playout of a complete presentation.

Load Slide: Schedules playout of an individual slide. You must select 
the presentation and specific slide.

Load Playlist: Schedules playout of a playlist. Browse to select a 
playlist (.xplst) file.

Execute Script: Schedules when to execute a script (.xsc) file that 
controls a slideshow presentation for broadcast.

Run Program: Schedules when to launch an executable program.

Unload All Presentations: Removes any loaded presentations or 
slides that have been loaded into the PDS Player.

Reset All: Clears the output of the CG renderer.

Unload and Reset All: Removes any loaded presentations or slides 
that have been loaded into the PDS Player and clears the output of 
the CG renderer.

5 In the Filename field, click Browse and select a presentation.

6 If you want to change the time, in the Event Time box, set the time at 
which to start playing the presentation. 

7 In the Preroll box, set the number of seconds.

8 Set the start date in the Event Date box.

9 If you want to repeat the presentation playout, enable Recurring Event. 
The Recurrence Pattern options appear.
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10 From the Recurrent Pattern options, set the frequency of recurrence. 
Choosing Daily, Weekly, and Monthly will appear.

11 From the Range of Recurrence options, set start and end dates.

12 Click OK.

13 The scheduled presentation and any recurrences you specified appear in 
the PDS Scheduler calendar.

To delete a scheduled event:

1 In the PDS Scheduler, select the event you want to delete and right-click.

2 In the menu that appears, select Delete Event. 

To delete a scheduled recurrence:

1 In the PDS Scheduler, select any one event from a recurrence you want to 
delete and right-click.

2 In the menu that appears, select Delete Recurrence. 
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To edit a scheduled event:

1 In the PDS Scheduler, select the event you want to edit and right-click.

2 In the menu that appears, select Edit Event… The Add Schedule Event 
dialog appears.

To immediately execute a scheduled event:

1 In the PDS Scheduler, select the event you want to execute and 
right-click.

2 In the menu that appears, select Run Event Now. 

To save and activate a schedule:

1 In the PDS Scheduler, click Save As….

2 In the Save As dialog box, provide a name for the schedule and choose 
Save.

3 The name of the schedule appears at the bottom of the PDS Player next to 
Active Schedule.
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Controlling the VertigoCG Renderer
The PDS Player lets you gain access to the CG rendering engine directly. This 
lets you start and stop the CG as desired.

To start and stop the VertigoCG, do the following:

1 In the PDS Player, choose Tools > VertigoCG > Start.

2 The CG rendering window appears.

3 When ready to stop the CG rendering engine, choose Tools > VertigoCG 
> Stop.

4 The CG rendering window disappears.

Using VertigoCG
The VertigoCG renderer allows direct configuration via a control interface, if 
enabled in the PDS Player Renderer Settings. When the VertigoCG rendering 
engine launches, a small interface launches.

1 The Load feature allows you to directly load .xml files in the CG 
Renderer. 

2 Click Disconnect to disconnect the renderer from the Player.

3 Click Exit to close the Renderer.
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4 Click Control Panel to launch the VertigoCG Control Panel.

Hardware Settings allow users to choose a video card device for output, 
select video and audio capture devices, whether to display the Renderer 
in full screen or in a moveable window, the TV output format (NTSC, PAL, 
etc.), and whether to display FPS along with the output.

Under Output, users can choose to view the output in Monitor or 
Windows Media 9 formats, if possible.

Under Video, users can choose whether to display Video on top and how 
many Video Buffers are present.

NOTE: The default PDS Player does not support changes in the hardware settings 
of the VertigoCG Renderer. Please contact Polycom Support before making any 
changes.
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5 The Software Settings tab provides another set of configuration options.

Users can change the scene directory, dictate a log file, change the TCPIP 
Port for the CG Renderer, change the Cel Cache Size, and enable 
MipMapping, a faster but more memory-intensive form of rendering. If 
MipMapping is enabled, users can adjust the negative level of detail bias.

6 When configuration has been completed, click OK. Click exit on the 
VertigoCG interface and reopen it.

NOTE: The default PDS Player does not support changes in the software settings 
of the VertigoCG Renderer. Please contact Polycom Support before making any 
changes.

NOTE: Changes made in the VertigoCG settings do not apply across PDS Player 
sessions and will be lost if the PDS Player application is closed and reopened.

Download from Www.Somanuals.com. All Manuals Search And Download.



Polycom Digital Signage Administrator Guide Controlling the VertigoCG Renderer

28 Polycom, Inc.

  

Download from Www.Somanuals.com. All Manuals Search And Download.



Polycom, Inc. 29

  

3
Using the Remote Manager

This chapter explains the interface and use cases for the Polycom Digital 
Signage Remote Manager. The installation of the Remote Manager is detailed 
in the Polycom Digital Signage Server Getting Started Guide.

This chapter contains the following sections:

• Main Window

• Tool Bar

• Network and Groups Pane

• Remote Player Management Console

Main Window
The PDS Remote Manager interface consists of the toolbars and four panes, as 
shown in the image below:
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The toolbars provide the buttons used for a number of high-level operations 
within PDS Remote Manager. Most other operations are available through 
dialog boxes that will be displayed (e.g., on a Player name or thumbnail 
image).

Networks and Groups Pane
The Networks & Groups pane shows a tree view of the hierarchy of networks 
and groups you can manage that are running on the PDS Server. Each network 
contains one or more groups (which may in turn have sub-groups).

The Network pane shows the Players defined within the network or group 
that is currently selected in the Networks & Groups pane. All the Players that 
are defined in the network or group will be shown, whether they are currently 
online or offline.

The Network pane has five tabs, allowing you to manage different aspects of 
these Players' operations:

• The Connections tab shows you the Players that are currently connected 
to the PDS Server (online) as well as those offline Players that have been 
connected recently. The Player list is tabular, and you can select the sorting 
order for the list by clicking a field heading.

— In the lower portion of the pane, the Connections tab will show you 
the list of users currently connected to the PDS Server.

• The Player Status tab relates information on Player connectivity.

• The Screenshots tab shows thumbnail views of the screenshots from the 
Players in the selected network or group. These thumbnails are refreshed 
regularly and will show the output from the Player as taken from the 
computer's graphics card. (The thumbnail refresh interval is set by the 
Auto-Refresh menu in the toolbar.)

• The System Info tab provides some basic system information, such as 
software and operating system versions, for each Player.

• The Packages tab shows the file download packages that have been 
defined for the selected network.

Events Pane
The Events pane shows a table of recent system events on the Players in the 
selected network, much like a shared log file. The most recent events will 
appear at the top of the table.
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Current Incidents Pane
The Current Incidents pane shows the actual log messages from PDS Server 
and the PDS Remote Manager. The events shown here are all major and minor 
log messages from the Polycom PDS Server and the PDS Remote Manager, 
including the events shown in the Events pane.

Status Bar
Finally, the status bar (at the very bottom of the PDS Remote Manager 
window) shows you the current status of PDS Remote Manager, indicating:

— the name of the PDS Server;

— the number of Players and managers currently connected to the PDS 
Server; and

— the name of your currently selected network.

In addition to the PDS Remote Manager main window shown here, PDS 
Remote Manager will bring up smaller windows for specific tasks, such as 
managing a Player or creating a file package. The PDS Remote Manager main 
window will still be available while the task windows are open.

Tool Bar

Connect/Disconnect
The Connect…/Disconnect button allows you to connect PDS Remote 
Manager to a PDS Server and to disconnect from the Server. Clicking Connect 
brings up the following dialog:

The default User Name/Password credentials are Administrator / 
Polycom123.
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Auto-Refresh Menu
The Auto-Refresh menu allows you to select the interval at which the status 
information in Remote Manager is refreshed. This includes refreshing the 
screenshots as well as all other system information displayed in the different 
tabs in the Network pane.

Refresh
Click Refresh to refresh the network information and screenshots manually. 
This button is particularly useful when the Auto-Refresh interval is set to Off.

Publish Content
The PDS Remote Manager includes a Publish Content dialogue. This tool is 
used to move content packages to PDS Player systems. Please note that, in 
most implementations, content updates will be performed through the PDS 
Web Controller rather than the Remote Manager.

The Remote Manager communicates directly with remote Players through the 
PDS Server. The publication process performs an inventory check against 
contents stored on remote Players. If content is missing, the Remote Manager 
creates a package to transfer to the Players. A package is a compressed archive 
containing all assets missing from the remote Player as well as all content 
added through the Publish Content tool.

NOTE: Please remember that each refresh requires data, including a screenshot 
image, to be sent from the Player system to the PDS Server and then from the PDS 
Server to your PDS Remote Manager. When managing a medium-sized or large 
network of Players, you can create a high level of network traffic and risk 
overloading your network simply by making your refresh interval too short.
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Publish New Content
Click Publish Content to bring up the Publish Content dialog. The dialog has 
a Package Name field at the top (enter the name of your content package here) 
and three tabs in the main section:

To publish content:

1 Click Add Files… to select files from your computer to be added to the 
package. You may select multiple files in the file browser by holding 
down Shift and clicking the file icons.

In the Assets view, you may also drag and drop the files you wish to 
publish.
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a The Assets tab and the Detail File List tab allow you to select from two 
different views of the list of files in the package.

2 Click Remove All to remove all of the assets from the package. (Select an 
asset and press the Delete key to remove only one asset from the 
package.)

3 Click Reset Target Paths to reset the destination paths for all assets back 
to their default values. 

4 To set individual destination paths, use the Assets view. The Assets view 
shows a small thumbnail image and size/resolution information. 
Right-click on an asset to bring up a context menu. Select Change Target 
Path… to bring up the Set Remote Destination Path dialog box:

5 In the dialog box, enter the destination directory for the selected asset. 
You may then click Cancel, click OK to apply the change only to the 
selected asset, or click Apply to All Assets In This Package to apply the 
change to all the assets in the package.

6 The Detail File List view shows more details, similar to the Details view 
in the Windows Explorer; click a column heading to sort by that column.
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Remove Old Content
If there is old content to be removed from the Players receiving the package, 
you can specify the file names for the old content in the Remove Old Content 
tab.

Click "Add Files" to add files to the removal list and bring up the deletion 
dialog:

Execute Actions
After you have selected your assets and made any required changes to the 
destination paths, click Next to bring up the Package Properties dialog:
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Publish Software Update
Polycom Digital Signage Remote Manager can be used to publish routine 
software maintenance updates to the network of Players. 

To publish a software update:

1 Click Publish Software Update. 

2 The Open Executable File dialog will appear. Choose a file and click 
Open.

3 The Package Properties dialog will appear.

If you wish to designate a specific timeframe in which to extract the 
package after publishing, do so in the Package Processing Schedule area.

The Command line should not be altered from the default.

4 Click OK. The Package will be compressed and published.

5 Consult the Events tab to ensure that the package has published and run.

6 Upon installing a software update, the PDS Player application will not 
automatically relaunch. Access the PDS Player via RDP and relaunch the 
Player application manually, or enter RESTART in the command space in 
Remote Manager and direct it to the Player.
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Network and Groups Pane
The Networks & Groups pane shows a tree view of the hierarchy of networks 
and groups of Players managed by the PDS Server. The network or group you 
select here will select the Players shown in the Network pane and the 
operations performed on those Players.

If you select a network or group which contains sub-networks or subgroups, 
then the Network pane will show the Players in the selected group as well as 
the Players in all its sub-networks and subgroups.

The title of the Network pane will change to show the name of the selected 
network and the selected group (if any).

Network and Player Management
The Network and Groups Pane is the main interface for network and player 
management. Right-clicking a network, group, or server in the Network and 
Groups pane will call up the following context menu:

The following sections will explain each function within this context menu.

Manage Groups
The Polycom Digital Signage solution offers two forms of hierarchical 
organization for players: networks and groups. Each player is associated with 
only one network or subnetwork. User permissions are determined by 
network: networks can have unique administrators, agents, and content 
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managers. One potential use case for multiple networks is for an organization 
with multiple geographic locations and unique content managers for each 
location.

Groups can incorporate players across multiple networks. Players can also be 
associated with multiple groups. Groups could be useful for an organization 
with multiple player roles -- internal, customer-facing, marketing-driven, and 
news-driven players could be grouped across networks and receive massede 
content updates.

1 Right click on a Server, Network, or subnetwork in the Networks and 
Groups Pane. Select Manage Groups from the context menu.

2 The Manage Groups window will appear.

3 Click Create Group. Name the group and click OK.

4 Drag and drop the PDS Players you wish to include in the group.

5 If you wish to delete or rename a group, right-click on the group. 

6 Click Apply and OK. The groups you have created (and any changes you 
have made to the groups) should appear in the Networks and Groups 
pane.
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Manage Players
The Networks and Groups Pane allows direct configuration changes to the 
Players on a Server.

1 Right click on a Server, Network, or subnetwork in the Networks and 
Groups Pane. Select Manage Players from the context menu.

2 The Edit Properties of Players menu will appear.

3 Click within the Player Name region to edit the name of a given PDS 
Player.

4 The Notes section automatically records recent network changes for each 
player; this section can be user-edited.

5 Click Save.
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Delete Offline Players
Offline Players can be deleted individually by right-clicking on the Player in 
the Connections tab of the Network pane. Alternatively, selecting Delete 
Offline Players will delete all offline Players in a network. Please note that 
online Players cannot be deleted.

1 Selecting the Delete Offline Players dialogue will launch the Offline 
Players menu. 

2 All Players not currently connected to the PDS Server, or Players that 
have been removed from a given Network or subnetwork, will appear in 
the Offline Players dialogue. 

3 Select the Players you wish to delete and click Delete Selected to remove 
them from the Remote Manager interface. Please note that when 
reconnected these Players will reappear in the Remote Manager.

4 Click Close when completed.
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Create New Network
New Networks can be created by right-clicking on a Server in the Remote 
Manager. Subnetworks can be created by right-clicking on a Network. 

1 Right click on a Server, Network, or subnetwork in the Networks and 
Groups Pane. Select Create Network from the context menu. The Create 
New Network window will appear.

2 Provide a Name and optional Network Description.

3 If you wish to designate a unique administrator for the Network, check 
Create user account for network administrator. 

Provide login credentials and a default email for this administrator. 

4 Click OK to complete.

5 To associate players with a network, drag them from the Connections tab 
of the Network pane into the given network or subnetwork. 

6 A warning will appear; click OK.

Delete Network
To delete a Network, right-click on the Network and select Delete Network. 
Click Yes on the warning that appears.

NOTE: The following cannot be deleted through the Remote Manager:
• The PDS Server
• Networks with subnetworks
• Networks with players associated (including greyed-out moved or disconnected 

players)
Delete subnetworks and move or delete all players before deleting a network.
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Manage Users
1 Right click on a Server, Network, or subnetwork in the Networks and 

Groups Pane. Select Manage Users from the context menu.

2 The Manage Accounts window will appear.

3 To delete an account, right-click on the username and select Delete 
Account.

4 Click Add Account to create a new account, or double-click on an existing 
account to edit the properties.

5 The Create New Account window will appear. 

6 Choose whether the account will be a Player Agent, Network 
Administrator, or a Content Manager.

— The Player Agent is the link between Players and the Server. It enables 
network status and health monitoring.

NOTE: The properties of the default Agent for each network cannot be changed, 
although they can be viewed. A new Agent can be created if you wish to change the 
Agent properties.
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— The Network Administrator oversees all configuration on a given 
network via the Remote Manager, as well as all content oversight 
abilities.

— The Content Manager has content update privileges on a given 
network via the Web Controller; the Content Manager can log into but 
make no changes in the Remote Manager.

7 Provide an email address and login credentials.

8 Click OK.

Download Agent Setup
Select Download Agent Setup if you wish to download the Agent for a 
particular network. Agent downloads should not be necessary in the default 
configuration of the PDS Server. Please consult Non-Standard Installations on 
page 159.

Broadcast Message

Administrators can broadcast a message to all Remote Manager users. To 
directly communicate with one user, see Manager List below.
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Network Pane
The Network pane shows different properties of the Players that are in the 
network or group selected in the Networks & Groups pane.

Manager List

A list of managers appears below the Player list in the Network Pane. Details 
about managers currently online are visible here. 
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Double-clicking a manager’s username launches a chat pop-up: 

Connections

The Connections tab shows a table with one row for each Player. The table 
columns show the following information for each Player:

— Name

— Online status

— IP address

— Network

— Date and time it came online

— System ID

— Number of dropped connections

— Player (agent) version number
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— Date and time the Player was last online (for offline Players)

Note:

— The name in the network column indicates the network to which the 
Player belongs, which is useful when you have selected a network or 
group that contains sub-networks or subgroups.

— Players that are currently offline will be shown as dimmed, i.e., the 
text of their table row will be a light gray color, and you will not be 
able to perform most operations on them.

— You can sort the table entries by clicking any of the column headings. 
PDS Remote Manager will initially sort the table by Player name.

To bring up the PDS Remote Player Management Console, double-click the 
Player's row in the table.

Player Status
Like the Connections tab, the Player Status tab presents a table of the Players 
in the selected network, but with different columns of data to show status 
information for the PDS Player software and the computer.

The columns in the table show the following information for each Player:

— Name

— PDS Player status

— Self-healing setting

— Currently running playlist

— Current event number within the current playlist

— Windows page file size

— Virtual memory used by the CG (Player graphics application)

— Virtual memory used by the PDS Player application

— Total disk usage on the system

— Master volume level for the audio output

— Time stamp (in Player local time) of the last status information sent to 
PDS Server

— Time stamp (in Player local time) of the last Player "heartbeat" seen by 
the agent
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— Time stamp (in Player local time) of the last screenshot sent to PDS 
Server

— The full Windows file path of the currently running playlist

Please note that:

— Players that are currently offline will be shown as dimmed, i.e., the 
text of their table row will be a light gray color, and you will not be 
able to perform most operations on them.

— You can sort the table entries by clicking any of the column headings. 
PDS Remote Manager will initially sort the table by Player name.

To bring up the Remote Player Management Console, double-click the Player's 
row in the table.

Screenshots
The Screenshots tab displays still images of each Player's output as rendered 
by the graphics card on the system. The screenshots are updated at a regular 
interval (based on the Auto-Refresh setting in the toolbar), so watching the 
images in the screenshots provides a quick and effective way to check the 
output from the Players in the network.

Each screenshot is captioned, with the name of the Player and network shown 
immediately above the screenshot image.

You can adjust the size of the screenshot images shown in this view using the 
zoom slider immediately below the screenshot viewing area.
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You can select the monitor whose image is used for the screenshots by 
selecting from the pop-up menu immediately below the screenshot viewing 
area. You can select PDS Output Screen (this is the default option), System 
Primary Screen, or System Secondary Screen. (Note that if you select System 
Secondary Screen, Remote Manager will show a blank blue screen for all 
Players that have a single-monitor configuration.)

To bring up the Remote Player Management Console, double-click the Player's 
screenshot image.

System Info
Like the Connections and Player Status tabs, the System Info tab presents a 
table of the Players in the selected network, but with different columns of data 
to show detailed system status information for the computer.

The columns in the table show the following information for each Player:

— Computer name (as configured in the Windows "System Properties" 
control panel)

— Time zone (as configured in the Windows "Date and Time" control 
panel

— Player name

— PDS Server version number

— Days remaining in the PDS Player license (for temporary licenses)

— PDS Player Product ID (for licensing)

— Data Parser version (if PDS Data Parser is installed)

— Days remaining in the Data Parser license

— Heartbeat Server version number

— Package Handler version number

— Operating system version (see note below)

— Operating system "uptime" (i.e., time since the last system reboot)

NOTE: The Windows version number is shown as reported by Windows, and the 
format of this version number does not correspond exactly to the marketing names 
for Window versions. For example, Windows Vista is reported in the table as 
"Microsoft Windows NT 6.0.6001 Service Pack 1."
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— Players that are currently offline will be shown as dimmed, i.e., the 
text of their table row will be a light gray color, and you will not be 
able to perform most operations on them.

— You can sort the table entries by clicking any of the column headings. 
The PDS Remote Manager will initially sort the table by Player name.

Network Packages
Network packages can be observed from the Network Packages tab. To send 
network packages, open the Web Controller or use the Publish Content tool in 
the Remote Manager.
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Remote Player Management Console
Double-clicking a Player in the Network pane (double-clicking the Player row 
in a tabular view, or double-clicking the Player's thumbnail image in an image 
view) will bring up the PDS Remote Player Management Console window. 
This window presents more detailed status information on the Player and 
provides tools for managing and controlling the Player.

The Remote Player Management Console window consists of four parts:

• the menu bar and tool bar, which include the "Tools" menu and the 
buttons used for Player operations;

• the performance meter pane, which includes LED-style graphs to show 
the current levels for page file size, CPU usage, audio level, and disk 
usage;

• the screenshots pane, which includes a tab and display area to show the 
screenshots for each of the system's display outputs; and

• the status detail pane, with tabs to show different detail elements of the 
systems status (this pane is discussed in more detail below).
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Tools Menu
The Tools menu contains the following options:

— File Browser: Select this option to bring up a File Manager view, 
browsing the Player's file system, in a separate window. The File 
Manager is described in detail below.

— Close: Select this option to close the Remote Player Management 
Console window.

Note that you can work in the main Polycom Digital Signage Remote 
Manager Window and in the Remote Player Management Console at 
the same time, and you may also have multiple Management Console 
windows open at once. However, keep in mind that each open 
Management Console window receives a refreshed set of screenshots 
every five seconds, so each open window will consume additional 
network bandwidth.

Tool Bar
The tool bar contains a number of buttons for performing management tasks 
on the Player:

Start Process
The "Start Process" button allows you to start a new process on the Player. 
Click the button to bring up the Start Process dialog: 

— In the File Name field, enter the full path (on the Player) of the 
program to run.
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— In the Arguments field, enter the command-line parameters, if any.

— In the Working Directory field, enter the full path of the directory (on 
the Player) that will be the working directory for the new process.

— To cancel and return to the Remote Player Management Console, click 
Cancel.

— To schedule the process on multiple Players, click Start On… You will 
be brought to a new dialog with a tree view of the Player network. 
Select a Player to run this process by checking the check box next to 
that Player's name.

— To start the process on the current Player only, click Start.

File Manager
Click File Manager… to bring up a File Manager view, browsing the Player's 
file system, in a separate window.

The File Manager is described in detail in the section below.

Reboot
Click Reboot to reboot the Player immediately. (Note that this will reboot the 
entire system. This is the same as selecting Shut Down... > Restart from the 
Start menu in Windows.)

Set License
Click Set License to bring up a menu listing the components on the Player that 
can be licensed. Once you select a component, Remote Manager will display a 
dialog box with that component's product ID and a field for you to enter the 
component's license key.
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Monitoring Settings
The Monitoring Settings dialog box allows you to configure different settings 
for the Player Agent:

• Enable Self-Healing allows the agent to take corrective action should a 
Player experience a problem playing out content. 

• Load last played playlist… to have the PDS Player automatically load the 
previously running playlist any time it is started.

• In Player Startup, you can optionally enter the name of a playlist to be 
loaded by the Player when it starts up.

• Check Enable Audio Monitoring to allow the audio output and levels to 
be sent to the Server by the Player. If this is not checked, no audio 
information or levels will be checked or sent, and no audio alarms will be 
triggered, even if the Player is playing out audio.

• Use the Video Monitoring selection to choose the display output that 
should be monitored by the Agent-this should be the display receiving the 
output from the Player (usually the System Secondary Screen).

• The settings under Alarm Conditions allow you to control how quickly 
the Player Agent will send a notification to the Server when encountering 
the following potential problems:

— Missing video: This alarm condition occurs when the agent is not able 
to get any video output from the Player to provide a screenshot. This 
usually indicates a problem with the Player.
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— Missing audio: This alarm condition occurs when the agent is not able 
to obtain any audio output from the Player. This usually indicates a 
problem with the Player. (Note that Enable Audio Monitoring must 
be checked for this condition to trigger an alarm.)

— Missing heartbeat: The Player regularly updates a timestamp file (the 
"heartbeat") that is checked by the Agent. This alarm condition occurs 
when the heartbeat has not been updated by the Player in the specified 
interval. This usually indicates a problem with the Player; however, 
for very graphics-intensive templates or on lower-end Player systems, 
you may need to lengthen this interval to eliminate false alarms 
caused by the Player simply being overloaded.

• Click OK to apply your changes and close the dialog box.

• Click Cancel to discard your changes.

• Click Apply to apply your changes but leave the dialog box open.

• Click Apply To… to apply your changes to multiple Player systems. 
Clicking Apply To… will bring up a new dialog with a tree view of the 
Player network. Select Players to receive these changes by checking the 
check box next to each Player's name.

Edit Config
This is used for advanced trouble-shooting. Please do not modify these 
settings without direction from Polycom Support.

Restart Polycom Player
Click this if you wish to restart Player(s) in your network. If the Player does 
not have Load previous playlist selected, you will have to manually load a 
playlist using the Playlist Load functionality found in the toolbar. Alternately 
you could publish a playlist to the Player(s) using the Publish Content 
functionality, found in the main application window.

Playlist
This feature scans available playlists on the Player hard disk and conveniently 
lets you select one to load.

Command
Choose one of the commands that appears in the drop-down list to perform 
common tasks, such as clearing the screens. Please see Appendix A: Player 
Commands  on page 167 for a list of commands.
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Status Detail Panel
The Status Detail panel of the Remote Player Management Console provides 
granular and up-to-the-moment status information regarding the Player. The 
Status Detail panel also provides remote process management for the Player 
appliance.

The Status Detail panel consists of four tabs: Player Status, Running 
Processes, Windows Services, and File Manager.

Player Status

The Player Status panel provides a summary of the individual Players’ 
performance and present status. 
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Running Processes

The Running Processes tab functions as a process manager for the remote 
Player.

• To stop a process running on the PDS Player, right-click on the process 
and click Kill Process.
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Windows Services

The Windows Services tab displays the Windows services on the selected PDS 
Player. As with the Running Processes tab, users can remotely start and stop 
these services when necessary.

• To stop a running Windows service, right-click on the service and click 
Stop.

• To start a Windows service, right-click on the service and click Start.
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File Manager

The File Manager allows direct management of the files on the PDS Player. 
Using the File Manager, administrators can navigate through the files stored 
on the PDS Player.

• If you wish to alter or edit a folder, right-click on the folder. A pop-up 
appears:

— Copy Path to Clipboard: Copies the path of the folder as text.

— Rename/Move To: Allows users to rename or move the folder.

— Delete: Deletes the file.

— Create Package: Saves the folder as a PDS Package for distribution.
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• Right-clicking on a file will launch the following pop-up:

— View Tail: Launches a text editor which displays the last 50 KB to 5 
MB of data contained in a file.

— Edit File: Launches a text editor with which users can edit files.

— Copy Path to Clipboard: Copies the path of the folder as text.

— Compare...: Allows users to compare files across multiple Players. 
This tool is useful for ensuring that packages have published correctly. 
After running the comparison, the following window appears:

— Download...: Allows users to download files from a Player to the 
computer running Remote Manager.

— Copy To...: Allows users to copy the file to another location on the 
PDS Player.

— Rename/Move To: Allows users to rename or move the file.

— Delete: Deletes the file.
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— Execute...: Executes a specific file. Please note that this function allows 
users to browse for files to run, rather than using the Start Process item 
in the Remote Player Management Console Tool Bar.

— Load...: Directly loads PDS Playlists and Templates in the PDS Player.
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4
Using the Web Controller 

This chapter outlines the use of the Polycom Web Controller in content 
managment procedures. It contains the following sections:

• About the PDS Web Controller

• Installing the Web Controller

• Opening the Web Controller

• Web Controller Interface Guide

• Control Panel

• Playlist Editor

• Crawling Ticker

• Slide Show Tickers

• Video Slide Content

• Message Board/Webcast

• Alerts

• Settings

About the PDS Web Controller
The Polycom PDS Web Controller gives administrators remote control over 
the content and settings of individual Polycom PDS Players. In addition to its 
powerful central content management interface, the Polycom PDS Web 
Controller provides professionally-designed and fully customizable 
templates, automated news and data feeds, and direct Player oversight.
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Installing the Web Controller
Web Controller is supported on Windows XP, Windows Vista (32 bit), and 
Windows 7 (32 bit). Windows Vista and Windows 7 require the additional 
pre-installation steps outlined below.

Pre-Installation Procedures on Windows Vista and Windows 7
1 Open the Start menu. Type MSconfig in the Search field and click enter. 

The System Configuration window will open.

2 Go to the Tools tab.

3 Select the option Disable UAC under the “Tool Name” column.

4 Click Launch.

5 Restart the computer. 

6 Perform the installation steps detailed below.

Installation
1 Find the Polycom Digital Signage Web Controller installer in the 

C:\software directory on the Polycom Digital Signage Server. 

2 Distribute this file to your computer.

3 Double click on the PDS Web Controller setup .exe file. The PDS Web 
Controller setup screen appears. Click Next.
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4 Designate a destination for the file. The default directory, C:\Program 
Files\Polycom\PDS Web Controller, is recommended. Click Next.

5 Choose a folder to appear in the Start Menu. Click Next.
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6 A review screen will appear. Click Install.

7 Double click on the PDS Web Controller desktop icon to begin. 

Opening the Web Controller
When you first open the Polycom Digital Signage Web Controller application, 
you will be prompted to enter your login credentials:

The default server name is PDSSERVER. The default credentials for Content 
Managers are ContentAdmin/Polycom123.
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Please note that you should not need to edit the TCP Port when using the 
default PDS Server configuration.

Licensing the Web Controller
The Web Controller must be licensed prior to use. To license the Web 
Controller:

1 Navigate to File > License.

2 The License dialog will appear.

a In the dialog, click the Request a License Key button.

b Enter the PDS Serial Number. The PDS Serial Number, provided by 
your sales representative in your fulfillment email, is unique per 
customer and comprehensive across the Polycom Digital Signage 
solution. Do not discard this number.

3 Click Request License Key to request the license key, which will 
automatically populate the license key field in the initial dialog.

4 Click OK.
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Web Controller Interface Guide
After login and licensing, the Web Controller landing page appears. 
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Main Panel

All content management and Player configuration tools reside in the Main 
Panel of the Web Control.

Each tab is documented individually throughout the rest of the chapter.
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Player Monitor Panel

The Player Monitor Panel of the Web Controller user interface displays 
screenshots of all connected Players on the given network of the Polycom 
Digital Signage Server. Use the Zoom tool to change the level of resolution of 
the display.

To change monitor settings:

1 Right-click on the chosen PDS Player. Click Full Screen Monitor....
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2 The Full Screen Monitor pop-up will appear.

3 To change the Monitor view, open the Screen drop-down on the far left. 
Choose whether to view the PDS Output Screen, System Primary Screen, 
or System Secondary Screen. 

For more information about using multiple screens with the PDS Player, 
please consult Configuring PDS Player Video Settings on page 6.

4 To change the monitor’s update frequency, open the Update Interval 
drop-down and select a new timeframe.

Events Panel
The Events Panel provides feedback for PDS Web Controller users during the 
publication process. The events detailed include content updates, errors, and 
Player status changes. Changes made in the Web Controller may not take 
effect until the package has completed the download and processing of a 
package; this panel allows you to monitor the states of these processes.
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Changing the Layout
To change the layout of the above panels, navigate to View and choose 
Horizontal Layout or Vertical Layout. The Vertical Layout, selected by 
default, places the Monitor Panel to the right of the Main Panel; the Horizontal 
Layout places it below the Main Panel.

A user can also freely change the look and feel by dragging and resizing the 
panes within the Web Controller.

Style

The style selection menu allows users to choose a different visual style for the 
Web Controller.
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Control Panel
The Control Panel provides a set of direct controls over the Players in the 
associated network. The Control Panel is the starting point for content 
management on Players. Greater detail is provided on the subsequent tabs in 
the PDS Web Controller, but the Control Panel gives immediate access to 
overarching controls.

Player Controls
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The Player Controls section allows immediate changes to be made to the 
Player. Unlike text edits or playlist changes elsewhere in the Web Controller, 
one click on each of these options will update Players targeted in the selection 
wizard:

• Clear Screen: resets the Player and clears the Player screen. 

• Next Event: Advances to the next event in the playlist.

• Previous Event: Returns to the previous event in the playlist.

• First Event: Returns to the first event in the playlist.

• Restart: Shuts down the Player and restarts it. This tool can be used to 
perform a full reset of the application.

• Stop: Shuts down the Player.

• Disable Video: Shuts down video card output, bringing the Player into 
standby mode. Please note that the Player will cease output when this is 
chosen.

• Enable Video: Resumes video card output on the Player.

• Volume:

— Change the Audio Volume. 100 is the default; 0 will mute the output.

— Click Set Volume.

• Load Playlist: This option loads the playlist selected from the dropdown 
menu. Click Refresh to restart the playlist.
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Selection Wizard
After selecting one of the above options, the Player selection window will 
appear. 

Offline Players will display a darkened screen; online Players will show a blue 
screen. 

Click OK.

Editing the Announcement and Emergency Crawls

Note: In order for the changes made in the PDS Web Controller to take effect, all 
affected Players must be online and running the PDS Player application. Updates 
made offline will not take effect automatically.
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The Announcement and Emergency Crawls can be edited, started, and 
stopped from the Control Panel. These crawls will not change or stop the 
playlist in progress but will instead run at the top of the screen. To publish a 
crawl to a PDS Player:

1 To change an announcement, edit the crawl text field.

2 Click Start Crawl. The Player selection window will appear. Choose the 
target Player or Players for your announcement. Click OK.

3 The Announcement Crawl should appear on the Player shortly.
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Please note that the Emergency Crawl will appear in red:

4 To stop the crawl, click Stop Crawl in the Web Controller. The Player 
Selection screen will appear again; indicate which Player you wish to 
target and click OK.
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Playlist Editor
The Playlist Editor tab in the Web Controller provides controls over playlists 
displayed in the PDS Player.

To create, edit, or play Playlists via the Playlist Editor:

1 Select a Playlist from the Available Playlists drop-down range. 
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a To retrieve a specific Playlist from a player for editing, click Retrieve 
from Player. The Player Selection window will appear; choose a 
player and a playlist and click OK.

b To create a new playlist, click New. The Save As dialog appears. Enter 
a name and click OK. 

Alternatively, click Save As at the bottom of the Editor.
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2 The Playlist will then appear.

3 To add a template to the playlist: 

a Choose a template from the Available Templates drop-down menu.

b Choose the duration in seconds for which the template will run.

c Choose whether the item will run in the foreground (appropriate only 
for crawling tickers) or in the background.

d Click Add Template.

4 To change the configuration of an existing template, click on a 
Description, Duration, Layer, or Parameter field to launch an editor.

5 To move a template within a playlist, use the up and down arrows within 
the editor. The order of the template will determine when the template 
plays on the playlist.

6 To load a specific template within a playlist, click the Load link.
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7 To remove a single template, click the Remove link beside the template 
inside the Playlist. To remove all templates from the Playlist, click Clear 
All. To delete the Playlist altogether, click Delete Current Playlist. 

8 When all configuration changes have been made, click Save to save the 
Playlist within the Web Controller.

9 Click Distribute to send the Playlist to the selected target Players.

10 Click Load on Player(s) to load the Playlist on the selected target Players.

Adding Content through the Playlist Editor

Content Directory
Prior to making changes to PDS Player content by means of the PDS Web 
Controller, content managers should create a central directory for all video, 
text, and PowerPoint files intended for distribution to PDS Players. These 
directories must reside on the C: drive of the computer running the Web 
Controller. 

For situations in which a single content manager is responsible for all content 
distributed on a network, Polycom recommends creating the directory 
C:\Content. 

For implementations in which multiple content managers oversee the same 
network, we recommend creating the directory C:\[ContentManagerName].

If properly configured on the computer running the Web Controller, this 
directory will automatically be created on the target players during the Playlist 
publication process. 

NOTE: Data files that supply information for the various Trivia, News, and Weather 
templates must reside in the C:\XPresenterContent\Data directory. The processes 
for updating these files are outlined in subsequent sections below.
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Default Playlist
The PDS Player and PDS Web Controller ship with a preconfigured default 
playlist:

The following templates constitute the default playlist:

• Lower Crawl: the crawl that plays throughout the playlist. Can be edited 
in the Crawling Ticker tab in the Web Controller. To remove the crawl 
from the PDS Player output, delete this template from the playlist.

• Entertainment News: a default data feed that displays entertainment 
news from a pre-defined feed. This feed updates regularly and populates 
the template with headlines, stories (usually one or two sentences), and 
images if possible.

• Trivia: a template that displays trivia questions and answers generated by 
a data file. 

• Weather 3Day: displays local weather for the next three days.

• Event Calendar PowerPoint: Displays a user-designated PowerPoint. 
This PowerPoint can be retrieved, edited, replaced, and distributed (as ppt 
or as a jpg archive) via the Slide Show Tickers tab in the Web Controller.

• Video 4x3: Displays a user-designated standard ratio video. This template 
is editable in the Video Slide Content tab of the Web Controller.

Download from Www.Somanuals.com. All Manuals Search And Download.



Playlist Editor Using the Web Controller

Polycom, Inc. 81

  

• Sports Headlines: a default data feed that displays sports news from a 
pre-defined feed. This feed updates regularly and populates the template 
with headlines, stories (usually one or two sentences), and images if 
possible.

• Video 16x9: Displays a user-designated widescreen video. This template 
is editable in the Video Slide Content tab of the Web Controller.

• Product Catalog PowerPoint: Displays a user-designated PowerPoint 
presentation. This PowerPoint can be retrieved, edited, replaced, and 
distributed (as ppt or as a jpg archive) via the Slide Show Tickers tab in the 
Web Controller.

Templates
The PDS Web Controller includes a library of default templates that can be 
added to a playlist from the Available Templates drop-down. The 
information and possible parameter changes for each of these additional 
templates follows.

AddOn L Bar Streaming Video

The AddOn L Bar Streaming Video template displays a streaming video or 
URL, a fixed message, and a text ticker.

1 Click on the Params link beside "AddOn L Bar Streaming Video."

NOTE: The Default Playlist includes preconfigured text, video, and PowerPoint 
presentation content. However, these elements are intended to be user-edited. For 
information on adding and editing content in templates, please see below.

NOTE: Websites are not resized automatically. Some sites may be restricted on 
player output given the resolution.
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2 The Template Parameters screen will appear.

3 To add a live video stream or website display, enter the URL in the text 
field under VideoStreamSource.

4 To add a static message:

a Click the browse (...) button under Message_Title.

b In the dialog that appears, choose the text file with the message title.

c Click Open.

d Next, click the browse (...) button under Message_Body.

e In the dialog that appears, choose the text file that contains the 
message body.

5 To add a message ticker:

a Click the browse (...) button under Message_Ticker.

b Select a text file. The Message Ticker displays two lines of text at a 
time; ensure that your text file is edited properly.

c Click Open.

6 Click OK when all changes have been completed.
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AddOn PowerPoint Schedule:

Displays a PowerPoint slide of your choosing; this template is intended to 
display a calendar or schedule created in PowerPoint. To add your own 
schedule template:

1 Click on the Params link beside "AddOn PPT Schedule."

2 The Template Parameters screen will appear. 

3 Click on ‘...,’ the browse button. This will bring up your list of available 
PowerPoint templates for selection.  

Click on the PP_Ticker_Schedule.ppt file.  Right-click on this file and 
select Open. 
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4 PowerPoint will launch. You will then have the below PowerPoint slide 
available for changes and population of your required data.

5 From here you can adjust the default information, including location 
names, time intervals, meeting names, etc., using the PowerPoint 
application. 

To change the style of this PowerPoint schedule:

a Click Select in the PowerPoint Editing panel in the Home tab. Select 
Selection Pane from the drop-down menu that appears.
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b Scroll to the bottom of the Selection Pane. Toggle layer visibility to 
match styles. The options outlined in dashed red dictate table style; 
the options outlined in solid blue dictate background style.

6 Once you have made your changes, save the PowerPoint slide and click 
Open in the selection dialog.

7 Click OK to complete template editing.

AddOn Video Clip, PowerPoint, Message

The AddOn Video Clip, PowerPoint, Message template displays a 4x3 video 
file, PowerPoint ticker, and text file. To configure an AddOn Video Clip, 
PowerPoint, Message template:
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1 Click Params. The Template Parameters screen will appear.

2 To add a video:

a Click the browse (...) button under ClipFilename.

b Choose a video file in the dialog that appears.

c Click Open.

3 To add a PowerPoint ticker:

a Click the browse (...) button under PPT_Ticker.

b Choose a PowerPoint file in the dialog that appears.

c Click Open.

d You will be prompted to create a PowerPoint archive. Click Yes.

4 To edit the message text:

a Click the browse (...) button under Message_Text.

b Select a text file in the dialog that appears.

c Click Open.

5 Click OK.
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AddOn Video Fullscreen

Displays a full-screen video. To add a video:

1 Click on the Params link. The template dialog window will appear.

2 Click the browse (...) button. Choose a video file from your content 
directory and click Open.

3 Click OK.

AddOn VideoStream

Displays a live video stream; if a non-video URL is designated, the template 
will display that URL. To add a video stream:
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1 Click on the Params link. The template dialog window will appear.

2 Enter in the source URL for the website you would like to reference.  
Click OK.  Once changes are made, save and distribute to the players.

Alert Fullscreen 

Displays an alert screen. See Alerts below.

Data Ticker Fullscreen

Displays a data-driven news feed. To add:

 

Download from Www.Somanuals.com. All Manuals Search And Download.



Playlist Editor Using the Web Controller

Polycom, Inc. 89

  

1 Click on the Params link. The template dialog window will appear. 

a Click the Add File or ... button beside the Datasource field. Locate the 
.xdsrc file on your computer and click Open.

b Remove all pathway and file type information from the chosen file. 
The Datasource field should contain only the file name of the .xdsrc 
file, without the file extension.

In our example, 
C:\PolycomContent\Data\PolycomFeed_PolycomFeed.xdsrc 
becomes PolycomFeed_PolycomFeed in the Datasource field.

c Provide a title and category for the Template.

2 Click OK.

Lobby Crawl

Displays the crawling ticker. Once the ticker has been begun it will play 
throughout the Playlist. See Crawling Ticker below.

PowerPoint Ticker LBar

Displays a PowerPoint ticker. For more information, consult Slide Show 
Tickers below.

NOTE: Please consult the “Using the Data Parser” on page 147 for more 
information on configuring .xdsrc files.
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Message Board 

Displays the Message Board. For more information, consult Message 
Board/Webcast below.

Trivia 

Displays a Trivia sequence. To edit the Trivia questions and answers:

1 Click on the Params link. The Template Parameters window will appear.

2 The NumQuestions field allows users to define the number of questions 
displayed on this template from the source Excel spreadsheet.  

The Title is the name that will be displayed on the template. 

The DataFilename is the source Excel spreadsheet which will be called for 
this application. The syntax of the file must be "lib_Trivia.xls". 

3 To customize the questions, open the C:\XPresenterContent\Data folder 
on your computer.  Double-click on the lib_Trivia.xls file.
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4 This will launch Excel and open the spreadsheet:

5 Type in your desired question under the Question row, four responses in 
the Options columns, and the correct response in the Answer column. 

6 Save your changes in Excel.

7 Launch the Remote Manager application.

8 Click on Publish Content. The Publish Content wizard will appear. 
Please consult “Publish New Content” on page 33 for more information 
on using the wizard.

9 Add the lib_Trivia.xls file. If it is not currently located with the 
C:\XPresenterContent\Data directory, you will need to designate this 
target pathway.

10 Click through the Wizard.

11 Select the Players or Group of players you want to target and distribute 
the file. 

12 The Trivia template will now refer to the revised document.

Video + PowerPoint

The Video + PowerPoint template displays a full-screen webcast.

Video 16x9 

Displays Windows Media, Quicktime, Flash (.swf), and H.264 video content in 
16x9 widescreen format. See Video Slide Content below.

Video 4x3 

Displays Windows Media, Quicktime, Flash (.swf), and H.264 video content in 
4x3 standard format. See Video Slide Content below. 

Weather 3Day 

Displays a three-day weather forecast generated from a data feed.
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Crawling Ticker
The Crawling Ticker is an animated item that runs at the bottom of the Player 
screen. The ticker can be populated with user-designated text or with an 
automatically-generated feed of news stories, entertainment news, or sports 
news.

To change the crawling ticker:

1 Select a crawl data source from the drop-down menu. Click Apply.
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2 If you have chosen a manual crawl, enter your message in the Manual 
Crawl Text field. 

If you wish to fill the field with the crawl text currently running on a 
Player, click Retrieve From Player. The Player Retrieval screen will 
appear. Select a Player and click OK.

3 Click Save.

4 Click Update on Screen.

5 To remove the crawl from the PDS Player output, delete the Lobby Crawl 
template from your playlist.

Note: It is always necessary to click Update on Screen in order to effect a 
configuration change on the target Player. However, although the change will 
appear on the target Player, your changes will not be saved without first pressing 
the Save button. 
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Slide Show Tickers
The Slide Show Tickers tab allows administrators to directly edit and replace 
frequently-updated elements of the playlist, the Event Calendar, Product 
Catalog, and About Company Text.

To update the Event Calendar and Product Catalog:

1 Click Edit File under the element you wish to change. PowerPoint will 
launch if it is not yet open. 

2 The Event Calendar or Product Catalog .ppt will appear. Edit the 
PowerPoint file as necessary..

Note: the Event Calendar and Product Catalog PowerPoint tickers are named 
according to suggested use but can be freely administrator-defined depending on 
your needs.
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Save the file and select the target Player. Do not alter the default save 
location. 

3 If you wish to retrieve a Calendar running on a particular Player and 
redistribute to another Player, click Retrieve from Player.

4 Alternatively, if you wish to replace rather than edit the existing 
PowerPoint ticker, select Import PowerPoint File. 

A warning will appear; select Yes, choose the file, and click Open. You will 
then be prompted to provide a target Player.

5 Select or unselect Create PPT archive. When selected, the PowerPoint file 
will be sent as a .jpg archive.

6 Click Send. The archive will be created and you will be prompted to 
select a target Player again. 

To edit the About Company text:

1 Edit the About Company text field. To retrieve the message from a 
particular player, click Retrieve From Player.

2 Click Save. Then click Update Screen.

Note: If you do not have PowerPoint installed on the target Player, you must select 
Create PPT Archive.

Note: Text longer than 500 characters (including spaces) will be unreadable in the 
About Company field. 

Download from Www.Somanuals.com. All Manuals Search And Download.



Polycom Digital Signage Administrator Guide Video Slide Content

96 Polycom, Inc.

  

Video Slide Content
The Video Slide Content tab allows changes to be made to the video template 
in the playlist. From this tab, users can edit the Sidebar Message, the Standard 
Format Video Clip List, and the Widescreen Video Clip List.

To edit the Sidebar Message:

1 Edit the Title and Text fields as necessary.

2 Click Save. Then click Update Screen. The new Sidebar Message should 
appear.

To edit the video clip lists:

1 To add a video file to the clip list, click Add Clip. You can then browse 
and select a file to add. Please ensure that the clip is a supported format 
(Windows Media, Quicktime, Flash (.swf), or H.264).
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2 To change the order of appearance of the clips in the list, use the upward 
and downward-facing arrows to rearrange the clips.

3 To remove a selected clip, click Remove. To remove all clips from a list, 
click Clear All.

4 Click Save Changes to save changes to the clip list. Click Load to update 
the template and display your changes.

Message Board/Webcast
The Message Board tab allows Content Managers to configure the Message 
Board playlist template or to stop the playlist and play a live webcast in its 
place.
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To edit the Message Board:

1 Edit the Text field as necessary. To remove all text from the field, click 
Clear.

2 Click Save to save the text in the field. To interrupt the playlist and show 
the updated Message Board, click Load Message Screen.

To reload the playlist with the updated Message Board, click Restart 
Playlist.

To load a webcast:

1 Indicate the URL of the webcast stream. Please note that the webcast 
should be in Windows Media Player-compatible format.

2 Click Apply URL. Choose a target Player from the selection wizard. 

3 Click Start Webcast. The webcast will start to play.

4 When the webcast has concluded, navigate to Reload Playlist. Choose a 
Playlist to play and click Load. Click Refresh to restart the given playlist 
once it is running.
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Alerts
The Alert tab allows content managers to stop the playlist to display an alert 
screen.

To broadcast an alert:

1 Edit the Alert Title and Alert Message text fields as necessary.

2 Choose whether to play one of the default Audio Alerts as well.
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3 Click Load Alert Screen and choose a target Player. The alert will 
display.

4 When the alert is no longer necessary, click Restart Playlist.
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Settings
The Settings tab allows you to simply apply overarching customizations to 
your playlist.

Style Sheet
A set of default style sheets come pre-configured with Polycom Digital 
Signage solution. These stylesheets apply to all templates within a playlist. To 
apply a new style sheet from among these default options, select an item from 
the drop-down menu and click Apply.

Customization
Administrators can replace the default logo with a custom logo. For the logo 
in the upper right, users can choose between a flipbook animation and a static 
image. To browse for an file, click the “...” link next to the existing file.

Administrators can also replace the logo that runs in the ticker configured in 
the Crawling Ticker tab. 

When all customization changes have been made, click Apply Customization 
Settings.
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5
Using Template Maker

This chapter explains the interface and use of the Polycom Template Maker.

This chapter contains the following sections:

• About Polycom Template Maker

• Installing Template Maker

• Licensing Template Maker

• Navigating the Template Maker Interface

• Template Maker Output Settings

• Adding and Working with Slides

• Adding and Editing Text, Images, and Media

• Adding and Editing a Crawl

• Adding Clocks and Tickers

• Saving a Template

About Polycom Template Maker
Polycom Template Maker allows users to work directly with Microsoft 
PowerPoint 2003 to develop templates for use in Polycom Digital Signage 
playlists. Template Maker can be used to create organization-, department-, or 
event-specific templates, with objects such as live video, video files, 
animations, tickers, and data feeds. 

Installing Template Maker
1 Find the Polycom Digital Signage Template Maker installer in the 

C:\software directory on the Polycom Digital Signage Server. 

2 Distribute this file to your computer.
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3 Double click on the PDS Template Maker setup .exe file. The PDS 
Template Maker setup screen appears. Click Next.

4 Designate a destination for the file. The default directory, C:\Program 
Files\Polycom\PDS Template Maker, is recommended. Click Next.

5 Choose a folder to appear in the Start Menu. Click Next.

6 A review screen will appear. Click Install.

7 Double click on the PDS Template Maker desktop icon to begin. 

Licensing Template Maker
1 From the Windows Start menu, choose Programs > Polycom Digital 

Signage > PDS TemplateMaker. 

Polycom Template Maker will launch. 

2 In the Template Maker companion window, open Tools > License 
Manager. 

The License Manager will appear.

3 Enter the License Key you have used for the other items in your Polycom 
Digital Signage solution. Click OK.

4 Template Maker should now be licensed.
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Navigating the Template Maker Interface
The Polycom Template Maker interface consists of two main sections: the 
Polycom Template Maker tool and the Microsoft PowerPoint interface that 
launches beside the Template Maker companion window..

This document assumes familiarity with the Microsoft PowerPoint interface. 
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The Template Maker Companion Window
The diagram below depicts the Template Maker companion window as it will 
appear upon first launching Template Maker. 

Toolbar

Current Slide Area

Selected Object Area

Render

Insert Flipbook
Launches a dialog
for viewing and
controlling flipbook
animations.

Insert Image
Launches a dialog
for importing an image
to the current slide.

Displays the name
of the current slide
and shows a tree view

 of all elements
 contained within a given slide. 

Insert Media
Launches a dialog for selecting
and previewing live video or a 
video clip for insertion to a slide.

Displays and permits 
modification of properties
 specific to the object selected
 in the PowerPoint slide, 
or properties of the currently
 active slide.

Renders the current slide
in the CG Renderer window.

Reset
Resets the output.

Layer
Selects which rendering layer
is currently active, and to
which layer objects contained
in the PowerPoint slide
will be rendered.

Save Slide as Template

Save Slide as Object

Reveals the layer specified
in the Layer drop-down.

Hides the layer indicated
in the Layer drop-down.
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Style Browser
To launch the Style Browser, navigate to Tools > Style Browser.

Select a Type from the drop-down menu:

• Text: Displays available text styles. In the Category box, choose from the 
list of categories.
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• Objects: Displays available graphic objects for each category. Some objects 
include links to live data. In the Category box, choose from the list of 
categories.

• Templates: Displays completed templates. In the Category box, choose 
from the list of categories.

• Images: Displays available image files, for example .jpg, .tga, .bmp. The 
Type box displays folders you can browse for selecting images. No 
categories are available for Images.

• Clips: Displays available video clips, for example .wmv, .avi, .mpeg. The 
Type box displays folders you can browse for clip selection. No categories 
are available for clips.

Template Maker Output Settings
The Template Maker rendering window should be configured prior to use. To 
launch the Settings dialog, navigate to Tools > Settings....

Video Settings

The Video Settings section includes the following configuration options:
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• Standard: Specifies the dimensions of the video output window. Choose 
from a list of standard resolutions: 640x480, 720x480 (DV-NTSC), 720x486 
(NTSC SMPTE), 720x576 (PAL), 800x600, 1024x768, 1280x720, 1280x1024, 
1600x1200, and 1920x1080.

• Custom: Specifies the dimensions of the video output window according 
to the specified Width (W) and Height (H).

• Orientation: Specifies whether the video output window should be 
displayed in either Landscape or Portrait format, in conjunction with the 
Standard or Custom output window dimensions.

• Auto size output to match slide dims: When selected, the resolution of the 
video output window will scale to match the slide template dimensions.

• Auto size slide to match output: When selected, the resolution of the slide 
template is automatically scaled to match the resolution of the video 
output window.

• Dual monitor mode: When selected, configures the PDS Player display 
output to appear on a second monitor. This mode can also be used for 
cloning the display. This supports multiuple monitors from one Player. 
See the Polycom Digital Signage Player Getting Started Guide for more details.

• Full screen: When selected, the PDS Player output will be displayed in full 
screen mode (either on the primary or secondary display). When 
unselected, the PDS Player output will be displayed in a separate window.

• Output Window Zoom: Select to resize the CG Rendering window to 
100% (full size) or 50% half size when the Full screen mode is disabled.

• Wait on VSync: Depending on the features and the performance of your 
system's graphics card adapter, select one of the following options:

— True: Significant loss of system performance with a high-quality 
graphics output result. 

— Hybrid: Improved system performance with some loss in the quality 
of the graphics output result.

— False: Best possible performance with a low-quality graphics output 
result.
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Advanced Settings

Renderer Settings
The Renderer Settings options of Advanced Settings are described as follows:

• Renderer IP Address: Displays the IP address of the rendering engine. 

• Renderer Executable Filename: Displays the executable filename that 
corresponds to the PDS rendering engine. 

• Connection Delay: Displays the delay, in seconds, from the time you click 
the Render button until the scene is submitted CG rendering engine. 

File Locations
The File Locations configuration in Advanced Settings allow users to dictate 
which directories the PDS Player uses:

• Output folder: Displays the folder to which the CG Renderer sends 
rendered output that is displayed in the output monitor. 

• Cache folder: Displays the folder to which the CG Renderer caches 
information while rendering the output. 

• Template folder: Displays the default folder to which the PDS Player 
saves exported templates. 

• Command folder: Displays the folder to which the commands are stored 
on the system for use with other PDS applications such as Remote 
Manager, or Web Screens. 
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Playout Settings
The Playout Settings of the Advanced Settings are as follows:

• Player Mode box:

— Standard: Configures the PDS Player to function as an authoring 
station.

— Interactive: Configures the PDS Player to function as an 
interactive/kiosk station. 

• Interactive Window: When in Interactive Player Mode, defines the 
topmost and leftmost location (XPos/YPos) and size (Width/Height), in 
pixels, of the interactive window.

• URL Loader Window: When displaying an internet browser window, 
defines the topmost and leftmost location (XPos/YPos) in pixels, of the 
Loader window.

Reviewing Template Maker Settings
After setting the Template Maker renderer settings, users should verify that 
the renderer is functioning properly with system hardware.

To verify renderer settings:

1 To load a PowerPoint presentation, in the PowerPoint main menu, choose 
File > Open. 

2 Browse to a PowerPoint presentation (.ppt) on your computer and choose 
Open. 

3 In Template Maker, click the Render button from the lower left corner of 
the screen.

The current slide is taken to the preview window, either to the second 
display or to the CG Renderer window. 

4 If the presentation renders correctly, click ALT-ESC to exit the renderer.

5 If the presentation fails to render and an alert appears at the bottom of the 
Template Maker interface, as pictured below, click the alert icon.

NOTE: Interactive mode is not supported in most implementations. Please do not 
select this option without input from Polycom support.
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6 The Messages dialog will appear.

Review the information and correct your configuration as necessary.

Adding and Working with Slides
Slides comprise all the assets, scripts, and data used to create a complete PDS 
template. While individual assets may have their own properties, slides may 
themselves include functions that modify content as it appears on-screen. All 
properties added to a slide are slide-specific.

Modifying General Slide Properties
Polycom Template Maker lets you customize the options available to slides. To 
access these properties, select the slide you wish to modify. The name Slide 
appears in the Selected Object area. 

The general properties associated with a slide are defined as follows:

• Slide name — Name used to reference the slide within the digital signage 
solution.

• Render With Alpha — If set to True, each slide element is rendered 
individually. Objects that contain alpha channels are composited against 
a background as expected. If set to False, the slide is rendered as a single 
image.

• Smooth Slide — If set to True, additional anti-aliasing will be applied to 
the slide when rendered (when Render with Alpha is set to False).

• Check For Duplicate Names — If set to True, the slide will be checked for 
duplicate object names. If objects have the same name, Template Maker 
will automatically reassign an unused name to the object to avoid 
potential issues that may occur with scripts or actions.

• Reset Renderer — If set to True, the CG renderer is reset (cleared) prior to 
the slide render.

• Layer — Layer that the slide is rendered on.

• Transition — Apply a transition to the current slide when navigating to 
another slide. Transitions from which you can select include Cut, Fade, 
Crossfade, Push Right, and Push Left.
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• Auto Clear Slide — If set to True, the slide will be cleared from the 
rendered output after a specified interval.

• Auto Clear Interval — The time, in seconds, after which a slide will be 
automatically cleared from the rendered output (if Auto Clear Slide is set 
to True).

• Auto Stop Crawl — If set to True, crawls will be cleared along with the 
slide during an Auto Clear Slide operation. If set to False, crawls remain 
on-screen when the content of the slide is cleared from the rendered 
output.

• Slide Dimensions — Resolution, in pixels, of the slide’s drawing canvas.

• Set Slide Dimensions button — Opens the Slide Dimensions dialog box 
in order to configure the slide’s drawing canvas. 

Modifying Background Slide Properties

The background properties associated with a slide are defined as follows:

• Background — Determines what is displayed as the background when the 
slide is rendered. Options available are Live Video Input, Video Clip, 
PowerPoint slide background, No background. See directions following 
for more information.

• X Position — Horizontal positioning of the slide background, in pixels 
(when Position is set to Custom).

• Y Position — Vertical positioning of the slide background, in pixels (when 
Position is set to Custom).

• Width — Width of the slide background, in pixels (when Position is set to 
Custom).

• Height — Height positioning of the slide background, in pixels (when 
Position is set to Custom).
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• Show Clip Proxy — If set to True, displays a thumbnail from a selected 
video clip as the background of the slide (when Background is set to Video 
Clip). If False, color bars are shown instead.

• Auto Advance — If set to True, automatically advance to the next event in 
the playlist when the background video clip ends (when Background is set 
to Video Clip). Also overrides specified slide duration settings.

• Cue Next Clip — If set to True, cues the next clip in the playlist in memory 
for use as a background (when Background is set to Video Clip). 

• Clip Filename — Opens the Select File dialog box in order to select a 
background video clip (when Background is set to Video Clip).

• Preview — Shows a thumbnail preview of the video to be used as a slide 
background. Click the image to show video playback controls in order to 
preview the video.

To import a video as a slide background:

1 Choose Video Clip from the Background option. 

2 In the Clip Filename area, select the browse button. 

The Select File dialog box appears.

3 To import a video clip from the Content Library, select the Content 
Library icon and browse to choose a video clip and click OK. 

The selected video clip appears in Clip Filename.

4 To import a video clip from another location on your system, select the 
All Files icon and browse to choose a video clip and click OK. 

The selected video clip appears in Clip Filename.

To receive a live video input signal as a slide background:

Choose Live video input from the Background option. 

The video source driving the background video is defined in the section 
Capture Settings of Template Maker Program Settings. 

A 3rd-party capture device is required to receive live video input from an 
external video device. 

To use the PowerPoint background settings as a slide background:

1 Choose PowerPoint slide background from the Background option. 

2 In PowerPoint, choose Format | Background… 

3 In the Background dialog box, select a color, fill, or texture to use as a 
background. 
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4 Position — Position and size of background. Options available are 
Default, Custom. 

Modifying Actions on a Slide
Slide actions let you automatically perform certain scripted functions when a 
slide loads. A series of actions can be created to form an action playlist.

The actions associated with a slide are defined as follows:

• Enable Playlist — If set to True, enables a slide’s action playlist.

• Edit Playlist button — Opens the Playlist Editor, letting you add, modify, 
and specify the duration of actions.

To add an action to a slide:

1 In the Actions tab of the slide properties, set Enable Playlist to True. 

2 Select Edit Playlist… The Playlist Editor dialog box appears.

3 To add an action, click Add. The Command Builder dialog box appears.

4 From the list of Available Commands, double-click on a command. If the 
command has customizable parameters, the Command Parameters 
dialog box appears. 

5 Configure the parameters as desired and choose OK. The Command 
appears in the Selected Command area.

6 To edit the selected command, click Edit… 

7 To adjust the start time of the selected command, modify its time by 
adjusting the H (Hour) /M (Minute) /S (Seconds) properties. 
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8 Choose OK to close the Command Builder dialog box. The action appears 
in the Playlist Editor.

9 To delete a command, select a command in the Playlist Editor and choose 
Delete. 

10 To edit a command, select a command in the Playlist Editor and choose 
Edit, or double-click on the command. 

11 Choose OK to close the Playlist Editor. The list of commands appear in 
the Playlist area.

12 To edit the playlist, choose Edit Playlist…. 

Adding Audio to a Slide
The Polycom Digital Signage solution supports .mp3, .wma, and .wav audio 
formats. Add as many audio files as you like to the audio playlist. The audio 
properties associated with a slide are defined as follows:

• Reset Audio — If set to True, automatically stops any previous audio that 
is playing when the slide is rendered to the output.

• Play Audio Clip — If set to True, plays audio clip(s) added to the Audio 
Playlist.

• Loop — If available and set to True, loops audio added to the Audio 
Playlist.

• Auto Advance — If available and set to True, automatically advances to 
the next playlist event when the audio playlist ends.

• Playlist Volume — Audio playout level (from 0-100).

• Use Default Master Volume — If set to True, uses default master volume 
defined by the Master Volume setting.

• Use Custom Mixer Settings — Applies settings created in the Mixer to 
audio in the playlist.

To add an audio clip to the slide’s Audio Playlist:

1 In the Audio Playlist area, choose Add File. The Select File dialog box 
appears.
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2 To browse to an audio clip on disk, click the browse button. A standard 
file explorer dialog box appears.

3 Select an audio file and choose Open. The audio file appears in the Audio 
Playlist.

4 To preview the audio file, select the file from the Audio Playlist and 
choose Preview. 

5 To remove the audio file, select the file from the Audio Playlist and 
choose Remove File. 

6 To add another audio file to the Audio Playlist, choose Add File. 

7 To change the playlist order of audio in the Audio Playlist, select a file 
and press CTRL+up or CTRL+down as desired. 

Adding and Editing Text, Images, and Media
The following section will outline how to use the tools in Template Maker to 
augment the template-creation tools within PowerPoint.

General Object Properties
The property configuration possibilities detailed in this section are identical 
for all objects in Template Maker. 

The general properties associated with an object are defined as follows:

NOTE: Please note, when working with text, that unlike other objects in a template, 
text remains a consistent size in Template Maker and the Polycom Digital Signage 
display. It will not resize in the renderer. Render a template with text from Template 
Maker before using it in a playlist.

Download from Www.Somanuals.com. All Manuals Search And Download.



Polycom Digital Signage Administrator Guide Adding and Editing Text, Images, and Media

118 Polycom, Inc.

  

• Display Name — Name used to reference the object within the digital 
signage solution.

• Full Name — Full name of object used internally by Microsoft 
PowerPoint.

• Type — PowerPoint object type.

• Visible — Specifies whether the object is visible in PowerPoint and on the 
PDS output.

• Opacity — Specifies the transparency level of the object when viewed on 
the PDS output. Setting the Opacity level does not affect the appearance of 
the object in the PowerPoint slide.

• Render On Output — Determines whether or not the object is displayed 
on the PDS output when the slide is rendered

• Left — X-coordinate of left side of object (in pixels).

• Top — Y-coordinate of top side of object (in pixels).

• Width — Object width (in pixels).

• Height — Object height (in pixels).

• Update Effect — Specifies transition effect to use when object is updated 
dynamically. Render on output must be enabled. The following options 
are available:

• Cut — No effect is applied. This is the default setting. 

• Fade — Fades up the image as the slide is updated.  

• Crossfade — Fades between the last state of the image and the updated 
image. 

• ScaleX — Stretches the object along its width (X-axis). 

• ScaleY — Stretches the object along its height (Y-axis). 

• ScaleXY — Stretches the object proportionately along its width and height 
(X-axis and Y-axis are scaled). The resulting effect looks as though the 
image is approaching the viewer from or flying away into the background. 

• Effect Speed — Speed of Update Effect transition. The following options 
are available:

• Slow — Effect proceeds at a slow pace. 

• Fast — Effect proceeds at a fast pace. 

Working with Text
After adding a text box to a slide in the PowerPoint section of the Template 
Maker interface, users can configure the text further using the tools in 
companion window.

Users can also add new text.
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Applying a Text Style
With the Text Style Browser, you can apply text styles to text in text objects, 
and create a text object from an existing text style.

To apply a text style to a PowerPoint object:

1 Create a text box in your PowerPoint presentation.

2 Enter any text. (This text will be replaced upon applying the style.)

3 In the Style Browser, choose Text from the Type box. 

4 Choose a category from the drop-down menu.

5 Browse the text styles. Right-click the style in the browser and choose 
Apply Style. 

6 The text style is applied to the text. Edit the text box as necessary in 
PowerPoint.

To create a text object from the Style Browser:

1 In the Style Browser, choose Text from the Type box. 

2 Choose a category from the drop-down menu.

3 Browse the text styles and click a style of your choice. 

4 Right-click the selected style and select Insert Text. Alternatively, 
double-click the given style.

5 A text box with the selected style will appear in the center of the slide. 
Edit the text box as necessary in PowerPoint.

To add new text styles to the Style Browser:

As you customize the look and feel of a text object so that it conforms to the 
style of your current production, you will most likely want to reuse the text 
style on subsequent slides. You can easily add a text style to the Style Browser.

The Text Style Gallery has its own PowerPoint file—named 
StylesText_Default.ppt—which you must open to add a new style. You then 
copy the newly designed text object from the PowerPoint file in which you are 
working to the Text Style Gallery PowerPoint file.
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1 In the Style Browser, be sure Text is selected as the Type and right-click. 

2 From the menu that appears, choose Edit. 

The Style Browser PowerPoint file named StylesText_Default.ppt opens. 
Notice the Slides tab contains each Text Style as an individual slide. You 
will copy your slide with the text object and paste it here.

3 Return to the text object slide in your file. In the PowerPoint main menu, 
choose View > Switch Windows > your filename. 

4 In the Slides tab, select the slide that contains the newly stylized text 
object. 

5 Right-click and choose Copy. 

6 In the PowerPoint main menu, choose View > Switch Windows > 
StylesText_Default. 

7 Create a new slide in the StylesText_Default file. 

8 Paste your text object into this slide.

9 Choose File > Save to save the StylesText_Default file and then close the 
file. 

The Text Style Gallery is updated with your new text style.

Modifying Text Properties

The Text Properties tab reveals options associated specifically with a text box, 
and are defined as follows:

• Text — Character string of text being displayed in the text box. To modify 
the contents of the text box from Template Maker, do the following:
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a In the Text Properties tab of the selected text box, click the Text field. 
The entire string of text is highlighted.

b Enter the text you wish to place into the text box. 

c Press Enter. 

• Enable Antialiasing — When set to true, edges of text are smoothed.

• Use CG Text — If set to True, use the PDS CG rendering engine to render 
text. This option must be set to true for dynamic text objects such as 
tickers. Some PowerPoint text formatting may be lost.

• Run Script on Change — If set to True, execute script functions whenever 
the text is dynamically updated.

• Script Module — Name of VBScript module containing the script 
function.

• Script Function — Name of VBScript function to execute when Run Script 
on Change is set to True.

• Run Action on Change — If set to True, execute action whenever the text 
is dynamically updated.

• Define Actions button — Opens the Action Editor dialog box to create 
actions associated with dynamic text.

• Set Format String — Opens the Format String dialog to automatically 
format or replace characters in the text box whenever the text is 
dynamically updated.

Working with Images

Inserting Images
Polycom Template Maker supports many image formats not importable into 
Microsoft PowerPoint alone. This includes many 32-bit image formats such as 
TGA, TIF, and Adobe Photoshop (.PSD) image files. These assets should be 
imported into PowerPoint using Template Maker menu options, and not using 
the PowerPoint menu options.

To import an image directly onto a slide, do the following:

1 Select the slide in PowerPoint.

NOTE: Template Maker may automatically adjust the Use CG Text setting based on 
the operations specified in other dialog boxes. 
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2 On the Template Maker toolbar, click the Insert Image button. 

The Select File dialog box appears.

3 To import an image from the preconfigured Content Library, select the 
Content Library icon and browse to select an image and click OK. 

The selected image appears on the slide.

4 To import an image from another location on your system, select the All 
Files icon and browse to select an image and click OK. The selected 
image appears on the slide.

To insert an image via the Style Browser:

1 Select Images from the Type drop-down menu.

2 Browse for images via the dialog below.

When the image you wish to add appears in the Style Browser, right-click 
and select Insert Image.
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Modifying Image Properties
The Image Properties tab reveals options associated specifically with an 
image, and are defined as follows:

• Use Key — If set to true, uses an external key as an alpha mask, defining 
which areas of the image are transparent, and which areas are not. 

• Run Script on Change — If set to True, execute script functions whenever 
the image is dynamically updated.

• Script Module — Name of VBScript module containing the script 
function.

• Script Function — Name of VBScript function to execute when Run Script 
on Change is set to True.

• Run Action on Change — If set to True, execute action whenever the 
image is dynamically updated.

• Define Actions button — Opens the Action Editor dialog box to create 
actions associated with dynamic images. 

• Set Image — Replaces the currently selected image with another image.
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Working with Media

Inserting Media
Polycom Template Maker provides the ability to import various forms of 
media as assets to be used in your digital signage application including video 
clips, live video feeds, live internet video streams, and even complete web 
pages.

To import media directly onto a slide, do the following:

1 Select the slide in PowerPoint. 

2 On the Template Maker toolbar, click the Insert Media button. 

3 A video color bar placeholder graphic appears on the slide.

Modifying Media Properties
The Video Properties tab reveals options associated specifically with a media 
file, and are defined as follows:

• Media Source — Selects the video source type. Options available are Clip, 
Video In, Video Stream, Web Page. This choice affects the configuration 
availabilities.

• Set Video Clip Properties — Opens the Video Properties dialog box to 
define the source of the media clip and set additional properties. See the 
following section for more information.

• Define Actions button — Opens the Action Editor dialog box to create 
actions associated with dynamic clips.

Source-Specific Configuration

• Clip:

— Run Script on Change — If set to True, execute script functions 
whenever the clip is dynamically updated.
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— Script Module — Name of VBScript module containing the script 
function.

— Script Function — Name of VBScript function to execute when Run 
Script on Change is set to True.

— Run Action on Change — If set to True, execute action whenever the 
clip is dynamically updated.

• Video In:

— Capture Source Index — Select the index of the video/audio capture 
device from the drop-down menu.

— Audio Volume — Select a volume from 1-100.

• Video Stream:

— URL — Specify the source URL.

— Audio Volume — Select a volume from 1-100.

• Web Page:

— URL — Specify the source URL.

• Clone:

— Source Object— Select the video clip to clone from the drop-down 
menu.

— Audio Volume — Select a volume from 1-100.

The Video Properties Dialog

To access the video properties of a media clip, do the following:

1 Select a media clip placeholder on a slide in PowerPoint. 

2 In Template Maker, select the Video Properties tab. 

3 Set the Media Source of the media clip to Clip. 

4 From the Video Properties tab, choose Set Video Clip Properties.
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The Video Properties dialog box appears.

Features available in the Video Properties dialog box are defined as follows:

• Clip List — Lists video clip or clips associated with the media asset 
placeholder. Template Maker lets you create video clip playback lists by 
adding more than one asset in the Clip List. Once more than one asset has 
been added to the Clip List, the order of the clips is modified by selecting 
an asset and pressing CTRL + up, to move an asset higher in the list, or 
CTRL + down to move an asset lower in the list.

• Clip Preview window — Shows a preview of the video selected in the 
Clip List.

• Enable clip proxy — When selected, replaces the color bar placeholder 
image for the media asset with the current frame shon in the Clip Preview 
window.

• Add Clip button — Selects a video source file from disk. To import a video 
directly onto a slide, do the following:

a Select the Add Clip button. The Select File dialog box appears.

b To import a video clip from the Content Library, select the Content 
Library icon and browse to choose a video clip and click OK. 

The selected video clip appears in the Clip List.

c To import a video clip from another location on your system, select the 
All Files icon and browse to choose a video clip and click OK. 

The selected video clip appears in the Clip List.

• Add Folder button — Selects a video source folder from disk.
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• Remove Clip(s) button — Removes selected video clip(s) from the Clip 
List.

• Loop — When enabled, loops the playback of all video clips listed in the 
Clip List.

• Randomize list — When enabled, randomizes the playback of video clips 
list in the Clip List.

• Log clip events — When enabled, creates a log file related to the playback 
of video clips in the Clip List. By default, logs are stored on the system.

• Advance to next slide when clip list ends (overrides playlist duration) — 
When enabled, adjusts the overall duration of the template currently 
playing such that the total duration of all clips in the clip list has 
precedence.

• Perform action on clip change — When enabled, execute action whenever 
the clip is dynamically updated.

• Define Actions button — Opens the Action Editor dialog box to create 
actions associated with dynamic images. 

• Run Script on clip change — If set to True, executes script function 
appearing in the adjacent drop-down list.

Working with Flipbooks
A flipbook—also known as a cel animation—is a set of sequential images that 
create the illusion of movement when played out in rapid succession. 
Supported file types are the same as for images. Flipbook animation sequences 
may be keyed over a live video input or clip and are typically used to display 
animated company logos. 

Inserting Flipbooks
To import an image directly onto a slide, do the following:

1 Select the slide in PowerPoint. 

2 On the Template Maker toolbar, click the Insert Flipbook button.

The Select File dialog box appears.

3 To import a flipbook from the Content Library, select the Content Library 
icon and browse to select the first image from a flipbook series and click 
OK. 

4 The selected flipbook appears on the slide.

5 To import a flipbook from another location on your system, select the All 
Files icon and browse to select the first image from a flipbook series and 
click OK. 

The selected flipbook appears on the slide.
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Modifying Flipbook Properties 
The Flipbook Properties tab reveals options associated specifically with a 
flipbook, and are defined as follows:

• Filename — The file path and first filename of the flipbook sequence. The 
source of the flipbook can be modified by clicking on the filename path, 
selecting the browse (…) button, and choosing a new source filename.

• Preview — Shows a thumbnail preview of the flipbook. Click the image to 
show flipbook playback controls in order to preview the flipbook.

• Loop — If set to true, the flipbook will loop continuously on the output.

• Loopback Frame — Frame to start from after every loop. This option is 
useful for when a flipbook sequence contains an introduction portion that 
need not repeat after successive loops of the animation.

• Frame Rate — Flipbook frame rate (in frames per second). This option is 
useful to control the overall timing of the flipbook, for example, if the 
sequence was rendered at a frame rate different from the desired playback 
frame rate.

• Proxy Frame — Sets the proxy thumbnail in the PowerPoint slide to be the 
frame specified, when choosing Set Proxy Image.

Adding and Editing a Crawl
With Polycom Template Maker, creating a crawl is quick and simple. Crawls 
can be global—each slide in the presentation can display a crawl without 
having to create a new crawl for each slide. Crawls can also be local—so that 
each slide has its own specific crawl. 

Crawl data can be entered manually by the operator during playout or the 
data can be fed automatically from any external, live data feed, a text file, or a 
database file. Crawls are available as slide properties. Crawls are also 
interchangeably referred to as crawling tickers.

Basic Crawl Configuration
To modify the properties of a crawl, do the following:

1 Select a slide in PowerPoint. 

2 In Template Maker, click the Slide indicator in the Current Slide area. 
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3 In the Selected Object area, select the Crawl tab. The slide crawl 
properties appear.

Select a crawl action from the drop-down menu.

» Do Nothing — Does not affect the state of the crawl. If a crawl is 
currently playing, it continues to play when the current slide is 
loaded. 

» Stop crawl — Stops the current crawl immediately when the 
current slide is loaded. 

» Start with default settings — Starts the crawl with default 
parameter settings. 

» Start with custom settings — Starts the crawl with custom 
parameter settings. 

4 Click the Set Crawl Properties button to open the Crawl Settings dialog 
box in order to create a custom crawling ticker.

Creating a Manual Crawl
1 In the Selected Object area, select the Crawl tab. 

2 Set the Crawl Action to Start with custom settings. 

3 Click the Set Crawl Properties button. 

4 The Crawl Settings dialog box opens.
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5 Set the crawl Type to Manual. 

6 Enter text into the Crawl Data text area, entering a line break in between 
each line of crawl data. 

7 Click Apply to instantly preview the crawl on the screen. 

Creating a Data-Driven Crawl
To modify the properties of a crawl, do the following:

1 Select a slide in PowerPoint. 

2 In the Selected Object area, select the Crawl tab. 

3 Set the Crawl Action to Start with custom settings. 

4 Click the Set Crawl Properties button. 

5 The Crawl Settings dialog box will open.
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6 Set the crawl Type to Data Driven. 

7 In the Data Filename field, click Browse to select an Access database or 
text file. 

8 Click Apply to instantly preview the crawl on the screen. 

Crawl Properties
Crawl properties apply equally for data-driven and manual crawls. The crawl 
properties associated with a slide are defined as follows:

• Type — Specifies the type of crawling ticker. Options available are either 
Manual or Data Driven.

• Loop crawl data — When checked, repeatedly loops the crawl data 
present in a manual or data driven crawl. When unchecked, crawl data 
appears once on-screen and then crawl playback stops.

• Advance playlist at end of crawl — When checked, advanced the playlist 
following the end of crawl data items.

• Image or Flipbook Filename — Specifies the path to an image or flipbook 
to use as a graphical separator in between lines of crawl data.

To add an image or flipbook graphic separator into the crawl, do the 
following:

a In the Image or Flipbook Filename field, click Browse. 

b Select an image or a flipbook image and click Open. 

c If adding a flipbook, check the Flipbook option. 
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d Set the width and height in the Image Width and Image Height fields 
and click Apply. 

• Opacity — Specifies the degree of transparency to the background crawl 
bar.

• Speed — Specifies the speed at which the crawl moves in the direction 
specified by Direction.

• Back Color — Specifies the color to the background crawl bar.

• Fore Color — Specifies the color of the crawl text.

• Drop Shadow — When checked, adds a drop shadow to the crawling text.

• Shadow Offset — Specifies the distance from the crawling text at which a 
drop shadow is drawn.

• Shadow Color — Specifies the color of the drop shadow.

• Direction — Specifies the motion of the crawl across the screen. The 
following options are available:

• Font — Specifies which system font to use for the crawl text.

• Copy From Slide button — Lets you copy the crawl settings configured in 
another slide.

• Copy From Clipboard button — Lets you apply the crawl settings to the 
Crawl Settings when a crawl has been copied to the clipboard.

• Copy To Clipboard button — Copies the Crawl Settings of the current 
crawl to the clipboard.

Option Description

Left Moves the crawl from the right side of the screen to 
the left. This is the default.

Right Moves the crawl from the left side of the screen to 
the right.

Up Moves the crawl from the bottom of the screen up to 
the top.

Down Moves the crawl from the top of the screen down to 
the bottom.
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Setting the Position of a Crawl
Open the Layout tab of the Crawl Settings dialog to set the crawl position 
within the template.

• XPos — Specifies the horizontal begin point of the crawl (in pixels).

• YPos — Specifies the vertical position of the crawl (in pixels).

• Width — Specifies the horizontal extent of the crawl across the screen (in 
pixels).

• Height — Specifies the vertical extent of the crawl across the screen (in 
pixels).

• Text YPos — Specifies the vertical positioning of the crawl text within the 
crawl bar (in pixels).

• Image YPos — Specifies the vertical positioning of the separator image 
within the crawl bar (in pixels).

• Crawl Spacing — Specifies the distance between lines of crawl data (in 
pixels).
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Adding Clocks and Tickers

Adding a Clock
Using Template Maker, text boxes can be configured to receive dynamic text, 
such as a running clock or date field, as opposed to simple text that is entered 
at design time into the text box itself. You can display a clock on a slide and 
keep it on for the entire production. The clock’s time is updated as its content 
is replaced on a continuous basis.

To specify the date or time in a text box:

1 In PowerPoint, create a text box object and select it. 

2 In the General tab of Template Maker, enter a descriptive name for the 
text box in the Display Name field.

3 In the Current Slide area, click Slide. The available slide properties 
appear.

4 Click the Next (>>) tab to reveal more slide properties and choose Clocks 
and Tickers. The TickerList area appears.

5 In the Clocks and Tickers tab, choose Add. The Ticker Properties dialog 
box appears.

6 In the General area of the Ticker Properties dialog box, enter a name to 
describe the ticker.
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7 In the Type drop-down list, select Clock.

8 Enable the Render output on change field, which automatically updates 
the ticker on the output when the object changes values.

9 In the Clock Settings area of the Ticker Properties dialog box, select a 
clock type from Type drop-down list. Available clock types are: 
Standard, Time Countdown, Second Countdown.

10 Choose a time display configuration from the Format drop-down list. 

11 Enter text to precede the clock or to follow the clock by entering 
characters in the Prepend Text and Append Text fields.

12 The clock can be offset by a time specified through adjusting the H (Hour) 
/M (Minute) /S (Second) parameters.

13 Enter a decimal point precision for the clock by choosing an integer from 
the Precision parameter.

14 Enable Stop at zero to stop the clock at the zero marker (when clock type 
is set to Time Countdown).

15 Enter a time value to countdown to in the Countdown To Time field; e.g.: 
“5/30/2007 10:00:00 AM” (when clock type is set to Time Countdown).

16 To target the text box created in step 6 above with the clock object, select 
the text box named “Time” in the Target Object drop-down list.

17 Click OK to close the Ticker Properties dialog box.

18 The name of the ticker created appears in the TickerList.

19 To add another ticker, in the Clocks and Tickers tab choose Add.
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20 To delete a ticker, select the ticker in the Clocks and Tickers tab and 
choose Remove.

21 To copy a ticker from one slide to another, select the ticker in the Clocks 
and Tickers tab and choose Copy.

22 To paste a ticker that’s been previously copied, from the Clocks and 
Tickers tab choose Paste.

23 To make changes to a ticker, select the ticker in the Clocks and Tickers tab 
and choose Edit.

Additional ticker options are described as follows:

• Run script on change — If set to True, execute script functions whenever 
the text is dynamically updated.

• Script Function — Name of VBScript function to execute when Run Script 
on Change is set to True.

• Perform action on change — If set to True, execute action whenever the 
text is dynamically updated.

• Define Actions button — Opens the Action Editor dialog box to create 
actions associated with dynamic text. 

Adding a Ticker
Template Maker lets you display data from various sources including 
Microsoft Excel spreadsheets, Access database files, as well as XML files. You 
can link a text box object to a single data element that appears when the slide 
is played out. Alternatively, the template can display several data items that 
are each on air for a specified period of time before being replaced by the next 
item.

To specify the date or time in a text box:

1 In PowerPoint, create a text box object and select it. 

2 In the General tab of Template Maker, enter a descriptive name for the 
text box in the Display Name field.

3 In the Current Slide area, click Slide. The available slide properties 
appear.

4 Click the Next (>>) tab to reveal more slide properties and choose Clocks 
and Tickers. The TickerList area appears.

5 In the Clocks and Tickers tab, choose Add. The Ticker Properties dialog 
box appears.

6 In the General area of the Ticker Properties dialog box, enter a name to 
describe the ticker.
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7 In the Type drop-down list, select Ticker.

8 Enable the Render output on change field, which automatically updates 
the ticker on the output when the object changes values.

In the Data Source area of the Ticker Properties dialog box, click the 
Browse… button to link to a database filename. 

9 To begin retrieving data from the first row of the database, enter 1 in the 
Starting Row field. 

10 To display one or more records at a time, adjust the parameter in the 
Return X records(s) at a time field. 

11 To continuously display or to wrap the records contained in a database, 
enable the Loop records and Wrap records options. 

The Text Search options are described as follows:

• Table/Worksheet box — Select the database table that contains the data 
you want to display. Click View to view the entire data file.

• Search Field box — Select a field based on the table selection. 

• Search Text field — Specify a string for which to search. 

• View button — Lets you view the data contained in the selected data.

• Allow partial matches — Enable to allow for the string to be matched by 
the first few characters and to find matching strings more quickly.

• Sort results — Sorts the contents and output order of the table based on 
the field specified by Sort Field.
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• Sort Field box — Select a field in which to sort the contents of the table 
when Sort results is enabled.

The SQL options are described as follows:

• SQL String field — Specify an SQL query to extract data from the database 
file. For details on creating SQL queries, see www.microsoft.com.

• View Data button — Lets you see the data retrieved from the entered SQL 
query.

• Refresh Field List — Refreshes the display of available fields.

The Specify Row/Col options are described as follows:

• Table/Worksheet box — Select the worksheet from which to select data. 
Click View to view the data in the selected worksheet.

• Row and Column boxes — Specifies the spreadsheet column and row 
location of the cell for which you want to display data for the selected 
worksheet. Click Select the view the spreadsheet details and select the cell.

1 To target the text box created above with the clock object, select the text 
box named “CityText” in the Target Object drop-down list. 

2 Repeat step 11 for all database fields you with to assign to other target 
objects. 

3 Click OK to close the Ticker Properties dialog box. 

The name of the ticker created appears in the TickerList.

4 To add another ticker, in the Clocks and Tickers tab choose Add. 

5 To delete a ticker, select the ticker in the Clocks and Tickers tab and 
choose Remove. 

6 To copy a ticker from one slide to another, select the ticker in the Clocks 
and Tickers tab and choose Copy. 

7 To paste a ticker that’s been previously copied, from the Clocks and 
Tickers tab choose Paste. 

8 To make changes to a ticker, select the ticker in the Clocks and Tickers tab 
and choose Edit. 

Other options available in the Ticker Properties dialog box specific to Tickers 
are described as follows:

• Ticker Interval (sec) — Time between when text objects are refreshed with 
new data from the database (in seconds).
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• Auto start on load — Begins displaying items in the database immediately 
after the slide is rendered to the screen.

• Advance to next slide after last record — Proceed to the next slide in the 
playlist after all records from the database have been displayed.

• Copy data file to prevent locking — Some database files, such as 
Microsoft Excel spreadsheets, may produce errors when simultaneously 
reading and/or writing to them from external applications. To let 
Template Maker create a local copy of the database file for use with tickers 
and to prevent file locking, enable this option.

Additional ticker options are described as follows:

• Run script on change — If set to True, execute script functions whenever 
the text is dynamically updated.

• Script Function — Name of VBScript function to execute when Run Script 
on Change is set to True.

• Perform action on change — If set to True, execute action whenever the 
text is dynamically updated.

• Define Actions button — Opens the Action Editor dialog box to create 
actions associated with dynamic text. 

Working with Objects

Inserting Objects on a Slide
When designing your slides, you can insert object styles on your slides. You 
can use any of these objects as a baseline and then modify color, contrast, and 
other properties to suit the design of your presentation. 

To apply an object style to a PowerPoint object:

1 In the Style Browser, choose Objects from the Type box. 

2 From the Category box, choose the category of objects that best suit the 
design of the slide. 

3 In the Style Browser, select an object and right-click. 

4 From the menu, choose Insert Object. 

The object is inserted on the slide. You can also click-and-drag the object 
into place on the PowerPoint slide. As you drag, a graphical 
representation appears representing the object, and the object’s 
proportions relative to the slide.
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Working with Object Groups
Individual slide elements can be grouped together and treated as a single 
object. When you use the Group command to group objects, you combine 
them so you can work with them as though they were a single object. You can 
flip, rotate, and resize or scale all objects in a group as a single unit.

You can ungroup a group of objects at any time and then regroup them later.

To group elements into an object, do the following:

1 Select one or more slide elements in a slide. 

2 Right-click on any of the elements, and from the right-click menu that 
appears choose Grouping > Group.

To ungroup object into individual elements, do the following:

1 Select an object group. 

2 Right-click on the group, and from the right-click menu that appears 
choose Grouping > Ungroup. 

Working with Animations

Animating Objects on a Slide
Animation presets simplify the use of animations for introducing, looping, 
and closing objects that appear in a template.

While a slide is playing out, objects on the slide can also have in animation and 
out animation effects when they appear and are removed from view.

To create animation for individual slide objects:

1 Select an object on a slide. 

2 In the Template Maker region, choose an Animation Type from the In 
Animation palette. 

3 If desired, choose an Animation Type from the Out Animation palette. 

4 For both In and Out animations, you can modify animation properties. In 
Animation and Out Animation panels have the same properties except 
the Out Animation panel does not have the option ‘Auto play on slide 
load.’ 

Modify animation properties as follows:
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— Animation Type — Select from a list of predefined animation effects. 
See “About Template Maker Animations” for a description of each 
animation.

— Preview button —Previews the selected animation effect in the CG 
Renderer.

— Offset box — Specifies the offset or delay at which at which to execute 
the animation. Use this value in conjunction with other objects to 
interplay animation effects among objects so that one object’s 
animation occurs at a different time than another object’s animation. 

— Duration field — Specifies the length of time, in seconds, that the 
animation effect takes to perform.

— Auto play on slide load — When enabled, starts the animation effect 
automatically as you move to the next slide in the presentation. This 
option is only available for In animations.

Types of Animations
The animations that can be applied via Template Maker include:

• Fly from Left: the object will appear to move from off-screen on the left 
side of the slide, and travel to the right.

• Fly from Left + Fade: the object will fade in while appearing to move from 
off-screen on the left side of the slide, and travel to the right.

• Fly from Right: the object will appear to move from off-screen on the right 
side of the screen, and travel to the left.

• Fly from Right + Fade: the object will fade in while appearing to move 
from off-screen on the right side of the slide, and travel to the left.

• Fly from Top: the object will appear to move from off-screen above the 
slide, and travel downwards.

• Fly from Top + Fade: the object will fade in while appearing to move from 
off-screen above the slide, and travel downwards.

• Fly from Bottom: the object will appear to move from off-screen below the 
slide, and travel upwards. 

• Fly from Bottom + Fade: the object will fade in while appearing to move 
from off-screen below the slide, and travel upwards.

• Fade On: the object will fade into view.

• Scale X: the object will appear compressed, and will stretch out along the 
horizontal axis of the slide, like an accordion.

• Scale X + Fade: the object will fade into view while appearing compressed, 
and will stretch out along the horizontal axis of the slide as it fades fully 
into view.
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• Scale Y: the object will appear compressed, and will stretch out along the 
vertical axis of the slide, as though it is “growing” up from the bottom of 
the slide.

• Scale Y + Fade: the object will fade into view appearing compressed, and 
will stretch out along the vertical axis of the slide, as though it is 
“growing” up from the bottom of the slide.

• Scale X + Scale Y: the object will appear to grow out of a single point in 
the distance and zoom into view.

• Scale X + Scale Y + Fade: the object will gradually fade into view while 
appear to grow out of a single point in the distance.

Saving a Template
Once a slide has been designed in Microsoft PowerPoint, user must export the 
slide as a template. 

1 In Polycom Template Maker, choose the Save Slide as Template button. 
Alternatively, navigate to File > Save Slide as Template.

2 The Template Settings dialog box appears.

3 Enter a Name for the template to export. 

4 In the Templates Root Folder, enter or browse to the local folder 
containing templates (typically C:\XpresenterContent\Templates). 
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5 To assign the template to one or more specific categories, in the 
Categories area, in the Existing Categories list box, browse to an available 
category and choose Add Selected. 

6 To assign the template to a new category, in the Selected Categories area, 
choose Add New Category. 

7 In the Add Category dialog box, enter the name of a new category and 
choose OK.  

8 The new category name appears in the Selected Categories list.

9 To remove the template from a category, select a category from the 
Selected Categories list and choose Remove Selected. 
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10 In the Template Parameters area, to add a variable parameter to the object 
that can be modified when the template is added to a playlist in the Web 
Controller, choose Add. 

11 The Template Parameter Properties dialog box appears.

The options available in the Template Parameter Properties dialog box are 
described as follows:

— Name — Specifies the name of the variable parameter.

— Description — Specifies a description of the variable parameter.

— Target Type — Specifies whether the parameter is an Object, Slide, 
Variable, or Data Ticker.

— Target — Depending on the Target Type, specifies what is targeted.
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— Target Property — Depending on the Target Type, specifies what 
property of the parameter is targeted. For example, when Target Type 
is Object, and Target is a text box, Target Property fields available are 
Text, Font, Color. When Target Type is Object, and Target is an image, 
Target Property field available is Filename.

— Parameter Type — Specifies the parameter type. Available options are 
Text, Image, Video, Audio, Filename, File List, Data Source, Color, 
Font, Boolean.

— Default Value — Specifies what placeholder text or link to file 
appears by default when initially inserting the object into the slide.

12 Click OK to close the Template Parameter Properties dialog box. 

13 In the Template Settings dialog box, to remove a parameter, select one in 
the Object Parameters list and choose Remove. 

14 To copy a parameter, select one in the Template Parameters list and 
choose Copy. 

15 To paste a copied parameter, choose Paste. 

16 To make changes to a parameter, select one in the Template Parameters 
list and choose Edit. 

17 In the Template Properties area, in the Description field, enter a 
description for the template to export. 

18 In the Preroll box, set the number of seconds. 

19 In the Slide Duration box, set the number of seconds the template is to 
remain on-screen. 

20 To include additional content associated with the template, choose 
Additional Files… 

21 To export the current slide as a template, choose Export Current Slide. 

22 To export multiple slides as multiple templates, choose Export All Slides. 

23 Click Close to close the Template Settings dialog box.
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6
Using the Data Parser

This chapter explains the interface and use of the Polycom Digital Signage 
Data Parser.

This chapter contains the following sections:

• About the PDS Data Parser

• Creating a Data Source

• Using a Data Source

About the PDS Data Parser
The Polycom Digital Signage Data Parser allows administrators to acquire, 
manage, and use live RSS feeds as a data source for the Polycom Digital 
Signage Player output. With the Data Parser, administrators can publish feeds 
from individual news outlets, topic-based searches, and specific geographies 
to any audience.

While this chapter outlines the RSS use case for the PDS Data Parser, the Data 
Parser can also ingest data from a wide variety of other sources. For 
information on other use cases, please consult Appendix B: Data Parser on 
page 171.

Creating a Data Source
In order to use an external feed in the Polycom Digital Signage Player, a data 
source must be created in the PDS Data Parser. 

To create a data source:

1 Launch the Polycom Digital Signage Data Parser.

2 Open Tools > RSS Wizard. 
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3 The RSS Wizard will appear. Click Next.

4 You will be prompted to designate a Data Feed Name and Database File, 
which should be changed from the default. These values must contain no 
spaces. You will also be prompted to enter the URL for your data source:

a Enter the URL of the feed. If you wish to browse for a feed, click 
Search RSS Feeds.

b Your internet browser will launch. By default the Data Parser will take 
you to Yahoo! News RSS feeds. 

c Choose a feed from the list presented or enter a topic or keyword into 
the Search textbox. In the example below, we have set a filter for 
“Polycom” in Yahoo! News.
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5 After designating a Data Feed name, URL, and Database File, enter the 
Refresh Interval. This value determines the time, in seconds, between 
live updates of the RSS feed.

Click Next.

6 The Title Format window will appear.

a Choose a Case Conversion method, if necessary, to modify the 
capitalization of all text contained in the Title/Headline section of the 
feed.

b Enter a series of Search & Replace character strings, if necessary, to 
strip out unwanted text, or to automatically add characters to the feed. 
The Format of the Search & Replace list is as follows:
[SearchText] | [ReplaceText]

For example, to automatically format incoming data, enter the 
following into the Search & Replace list:
<![CDATA[ | 

]]> | 

The Search & Replace will modify this string of text as follows:

Unformatted raw data:
<![CDATA[Polycom announces its Digital Signage 
Solution]]>

Formatted data:
Polycom announces its Digital Signage Solution

c If you wish to exclude items with certain words or phrases in the title, 
indicate those words and phrases.

Click Next.
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7 The Story Format window will appear.

a Choose a Case Conversion method, if necessary, to modify the 
capitalization of all text contained in the Story section of the feed.

b If necessary, enter Search and Replace formatting as described above.

c If you wish to exclude items with certain words or phrases in the 
body, indicate those words and phrases.

d Select Concatenate title and story text to merge Title data with the 
Story data, stored in the Story field of the database. To automatically 
place a character in between the concatenated title and story text, enter 
a character in the Separator text area.

Click Next.
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8 Verify the formatting and content of the incoming data feed by 
examining the text in the Data Preview panel. Click Next.

9 The completion screen will appear. Click Finish.

NOTE: Not all RSS feeds can be parsed and displayed correctly. Please confirm 
that titles and stories appear, and appear legibly, in the Data Preview panel.
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10 The feed created in the RSS Wizard will now appear as a Data Source in 
the Data Parser main menu. This means that a Data Definition .xml file 
and a .mdb Database File will now appear in the PDS Data Parser 
directory. 

For all subsequent steps, however, you will need to use the .xdsrc file 
located in C:\PolycomContent\Data.

Licensing Data Parser
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Using a Data Source
After a Data Source is created, it can then be used to replace the sources in the 
Entertainment, Breaking, and Sports News default playlist templates or to 
create a new FSData template. With the Remote Manager and Web Controller 
tools, administrators can distribute a data source created in any one Data 
Parser to all PDS Players in a network.

To use a data source in a playlist in a remote PDS Player:

1 Open the Remote Manager. 

2 If the data source has been created on a remote PDS Player, you will need 
to:

a Right-click on the PDS Player and open the Management Console. 

b Open the File Manager tab of the Management Console.

c Navigate to C:\PolycomContent\Data. Locate the .xdsrc file for the 
data source you created in the previous section.

d Download the .xdsrc file to the computer running Remote Manager.

e When the download has completed, close the Management Console 
and return to the Remote Manager main interface.

3 In the Remote Manager main interface, click Publish Content.

NOTE: All PDS Players must have Data Parser installed and running. To confirm 
that a Player has Data Parser installed, consult the System Info tab of the Network 
pane in Remote Manager. If the Dataparser Version, Dataparser License, and DP 
ID fields exist and are populated with data, the Data Parser should be installed on 
the target Player.
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4 Add the .xdsrc file to the Content Update. Right-click on the file and 
select Change Target Path. Enter the target path 
C:\PolycomContent\Data.

5 Click Next. Designate the Content Update Properties and all Target 
Players that will need to display the content and click OK.

6 The Events area of the Remote Manager should show that the Content 
Update has been downloaded and processed.

7 Open the Web Controller.
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8 Navigate to the Playlist Editor tab.

9 To edit an existing template, click Params next to that template. Please 
note that only the Entertainment News, Breaking News, and Sports 
Headlines default templates are appropriate for RSS feeds imported 

To create a new template, choose the Data Ticker Fullscreen template 
from the Available Templates drop-down and click Add Template.
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10 The Template Parameters Window appears. 

a Click the Add File or ... button beside the Datasource Field. Locate the 
.xdsrc file on your computer and click Open.

b Remove all pathway and file type information from the chosen file. 
The Datasource field should contain only the file name of the .xdsrc 
file, without the file extension.

In our example, 
C:\PolycomContent\Data\PolycomFeed_PolycomFeed.xdsrc 
becomes PolycomFeed_PolycomFeed in the Datasource field.

c Provide a title and category for the Template.

Click OK.

11 Save the Playlist, Distribute the Playlist to the target player or players, 
and click Load on Player(s).
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12 The new Template should appear in the PDS Player output. The Data 
Parser will update the Template as new material appears.
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7
Non-Standard Installations

This chapter outlines potential changes to the standard Polycom Digital 
Signage Server. This chapter includes the following sections:

• The PDS Server Configuration Utility

• Downloading and Installing the Agent

The PDS Server Configuration Utility
The Polycom Digital Signage Server includes a Configuration Utility to 
facilitate changes from the default Server settings. The Configuration Utility 
allows port, database, and setting changes.

After the setup processes detailed above, the PDS Server Configuration Utility 
can be used:

• To launch the Configuration Utility, open Start > Programs > Polycom 
Digital Signage > PDS Server Configuration Utility. The utility will 
appear.

NOTE: Port and name changes made in the PDS Server will not be propagated to 
the Players. You will need to update each of the Players, either by installing a new 
Agent or by manually updating the server configuration.
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• From the Server tab, administrators can designate a server address, the 
ports used by the server, the file transfer directory, and whether it is 
functioning as a primary or secondary server.

Port configuration information is detailed in the following section.

• From the Database tab, adminstrators can view database address and, if 
necessary, database authentication credentials.

NOTE: Do not alter the default settings in the Database tab unless instructed to do 
so by Polycom support.
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• From the Service tab, users can start, stop, and monitor the status of the 
PDS Server service.

Renaming the Server
The PDS Server Configuration Utility allows you to rename the PDS Server. 

To rename the PDS Server:

1 Open the PDS Server Configuration Utility.

2 Open the Server tab. Indicate a new name or IP address for your PDS 
Server. 

a Click Use Machine Name to use the name of the PDS Server appliance 
for the Server name.

3 Click Save in the PDS Server Configuration Utility toolbar.

4 In the Service tab, click Stop to stop the Polycom Digital Signage Server. 

5 Start the service.

6 Make all necessary subsequent changes via the Remote Manager and 
Player agents.

Port Configuration
The TCP ports used by the PDS Server can be changed via the PDS Server 
Configuration Utility. 
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To change ports:

1 Open the PDS Server Configuration Utility.

2 In the Server tab, provide a new Primary Port and Secondary Port.

3 Click Save in the PDS Server Configuration Utility toolbar.

4 In the Service tab, click Stop to stop the Polycom Digital Signage Server. 

5 Start the service.

6 If the Primary Port is open and available for use, the new port can be used 
in all subsequent connection and configuration processes.

Downloading and Installing the Agent
All PDS Players ship with the Player Agent preinstalled and preconfigured.

The default Player Agent will not be able to communicate with a Server that 
has been changed through the PDS Server Configuration Utility. Users who 
have made changes to the default Server settings must reinstall the Player 
Agent on each Player Appliance.

To download the agent:

1 Right-click on the network you intend to use in the left pane and choose 
Download Agent Setup.

2 Download the installer and save it in a place that you will remember.  
You will need this installer for distribution to the Polycom Digital 
Signage Player.

NOTE: Please be sure that the ports you choose are open and available for use.
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3 Copy the Agent installer executable file from the download location to 
the PDS Player.

4 Directly or remotely access the Player appliance. double-click on the 
Agent installer. The setup wizard will appear. Click Next.

5 A license agreement will appear. Select I agree and click Next. A 
summary screen will appear; click Install.

6 No post-install actions are necessary. After the agent is installed, verify in 
the Remote Manager that the Player is now listed.
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Changing Agent Settings on a Player
Polycom recommends downloading and distributing a new Player Agent 
when configuration changes have been made. The Agent configuration can be 
directly changed on each Player, however, to reflect PDS Server setting 
changes.

1 Right-click on the Agent (red cross on red field) icon in the Windows 
Taskbar on the Player Appliance.

2 Select Status from the context menu that appears. The Polycom Player 
Status window will launch.

3 Click Agent. Select Connection Settings from the menu that appears.

Download from Www.Somanuals.com. All Manuals Search And Download.



Downloading and Installing the Agent Non-Standard Installations

Polycom, Inc. 165

  

4 In the Connection Settings tab, enter your new Server Name and/or 
Server Port. 

Click Test Connection to confirm that the changes have been made 
correctly. Click OK to complete.
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A
Appendix A: Player Commands

This appendix contains a list of the commands available for use in Polycom 
Digital Signage applications and required parameters:

• Standard Commands

• Player-Specific Commands

Standard Commands
APPENDTOFILE|Filename|<Text to write. Replace line breaks with 
'<BR>' or '{BR}'>

CLEARCACHE

CLEARLAYER|<Layer (0 or 1)>

CLEARCRAWL|<Layer (0 or 1)>

CLEARCRAWLTEXT|<Layer (0 or 1)>

CLEARKEYER|<Keyer Num>

CLOSE

COPYFILE|<Source file>|<Dest file>

DELAY|<Delay in secs>

DELETEFILE|<Filename>

ENABLECONTROL|<Object name>|<Layer (0 or 1)>|<Enable (True or 
False)>

ENDPROCESS|<Process name>

EXECSCRIPT|<Script filename>

FLUSHSERIALBUFFER

LOADSCENE|<Keyer num>|<Scene xml filename>

LOADTEMPLATE|<Template name>|<Layer (0 or 1)>|<Param 
List>|<StyleSheet Filename (optional)>|<Transition (Optional: 
0-10)

MSGBOX|<Message text>

MUTESPEAKER|<Mute (True/False)>
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MUTEAUDIOCHANNEL|<Mixer channel>|<Mute (True/False)>

PLAYANIMATION|<Object 
name>|<Layer>|<Offset>|<Duration>|<X1>|<X2>|<Y1>|<Y2>|<Opacity1
>|<Opacity2>|<ScaleX1>|<ScaleX2>|<ScaleY1>|<ScaleY2>

PLAYAUDIO|<Audio filename>

PLAYFLIPBOOK|<Object Name>|<Layer (0 or 1)>

PLAYKEYFRAMEANIMATION|<Animation name>|<Layer (0 or 1)>

RAWDEVICECOMMAND|<Device Command>|<Command Params>|<Layer (0 or 
1)>

RESETALL

RESTARTTICKER|<Layer (0 or 1)|<TickerName>

SENDMONITORCOMMAND|<Port num>|<Monitor type (Defined in 
MonitorControl.txt)>|<Command (Defined in MonitorControl.txt)>

SENDSERIAL|<Port num>|<Baud rate>|<Parity>|<Data bits>|<Stop 
bits>|<Text to send>

SETBGCLIP|<Layer (0 or 1)>|<Clip filename>

SETCLIP|<Object name>|<Layer (0 or 1)>|<Clip filename>

SETCLOCK|<Year>|<Month>|<Day>|<Hour>|<Minute>|<Second>

SETCRAWLDATAFILE|<Data filename>|<Layer (0 or 1)>

SETCRAWLIMAGE|<Image filename>|<Layer (0 or 1)>

SETCRAWLTEXT|<Text>|<Layer (0 or 1)>

SETFLIPBOOK|<Object name>|<Layer (0 or 1)>|<Filename of first 
flipbook image>|<Process render queue (True or False, optional, 
default=True)>

SETIMAGE|<Object name>|<Layer (0 or 1)>|<Image 
Filename>|<Process render queue (True or False, optional, 
default=True)>

SETMASTERVOLUME|<Volume (0-100)>

SETOBJECTPOSITION|<Object name>|<Layer (0 or 1)>|<X pos>|<Y 
pos>|<Width (optional)>|<Height (optional)>

SETSLIDEAUDIOPLAYLIST|<Filename (or list)>|<Layer>

SETSLIDEAUDIOPLAYLISTVOLUME|<Volume (0-100)>|<Layer>

SETTEXT|<Object name>|<Layer (0 or 1)>|<New text>|<Process 
render queue (True or False, optional, default=True)>

SETVISIBLE|<Object name>|<Layer>|<Visible (True/False)>

SETVOLUME|<Mixer channel>|<Volume (0-100)>|<Device name or 
index, optional>

SHELL|<Shell command>

SHOWMESSAGE|<Message text>
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SIMPLECRAWL|<Layer>|<Image filename>|<BackColor 
(Black=0)>|<ForeColor 
(White=16777215)>|<YPos>|<Height>|<FontSize>|<';' delimited 
text>

SIMPLECRAWLUNICODE|<Layer>|<Image filename>|<BackColor 
(Black=0)>|<ForeColor 
(White=16777215)>|<YPos>|<Height>|<FontSize>|<';' delimited 
text>

SNAPSHOT|<OutputFilename>|<Width>|<Height>

STARTCRAWL|<Layer (0 or 1)>

STARTSLIDETICKER|<Layer>|<Ticker name>

STOPCRAWL|<Layer (0 or 1)>

STOPSLIDETICKER|<Layer>|<Ticker name>

SYNCFOLDERFILES|<Folder>|File list

WRITETOEVENTLOG|<Log message>

WRITETOFILE|Filename|<Text to write. Replace line breaks with 
'<BR>' or '{BR}'>

WRITETOLOG|<Log message>

Player-Specific Commands
CLEARALLPLAYLISTS

CLEARPLAYLIST|<Playlist number(optional, default=1)>

DONEXTEVENT

DOPREVIOUSEVENT

ENABLEMONITOR|<True/False>

FIRSTEVENT|<Playlist number(optional, default=1)>

GOTOEVENT|<Event index>|<Playlist number(optional, default=1)>

GOTOFIRSTEVENT|<Playlist number(optional, default=1)>

LOADPLAYLIST|<Playlist filename>|<Auto start (Optional, 
default=True)>|<StartIndex (optional, default=1)>|<Playlist 
number(optional, default=1)>

LOADSCHEDULE|<Schedule filename>

MINIMIZE

NEXTEVENT|<Playlist number(optional, default=1)>

PREVIOUSEVENT|<Playlist number(optional, default=1)>

RELOADEVENT|<Playlist number(optional, default=1)>

RESETCURRENTEVENTTIME|<Playlist number(optional, default=1)>

RESTART

SHUTDOWN
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SETLICENSEKEY|<License Key>

STARTPLAYLIST|<Playlist number(optional, default=1)>

STOPPLAYLIST|<Playlist number(optional, default=1)>
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B
Appendix B: Data Parser

This appendix contains a tutorial, examples and a reference guide for creating 
custom data source definition files. Creating a data source definition is an 
advanced topic that requires in-depth knowledge of pattern matching, 
Internet protocols and formats such as HTTP, HTML and particularly XML.

This appendix includes the following sections:

• Data Source Definition File Overview

• Data Source Tutorial

• Parsing Rule Reference Guide

Data Source Definition File Overview
A data source definition file contains a single XML <DataSource> element. A 
<DataSource> element contains a single <General> header element, followed 
by one or more <ParsingRule> and/or <DataItem> elements.

When Data Parser opens a definition file, it first reads the <General> element. 
Then it retrieves the data source's data and applies all top-level <ParsingRule> 
elements in the order they appear in the definition file. Finally, it applies all the 
<DataItem> elements, also in order of their appearance

.
Special Character Replacement Entity Code

& &amp;

< &lt;

> &gt;

“ &quot;

‘ &#39;
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For example, the following is invalid:
<StartTag>"Hello & Goodbye"</StartTag>

Instead, the special characters must be replaced:
<StartTag>&quot;Hello &amp; Goodbye&quot;</StartTag>

Note that all XML entity codes start with an ampersand (&) and end with a 
semicolon.

The General Element
The <General> element defines the basic parameters of the data source and the 
table into which the data source should be parsed. <General> contains five or 
six child elements:

• <Url> specifies the Internet location of the data source. Data Parser 
suports http, file, and ftp URLs. The URL should resolve into a text type, 
such as a plain text, HTML or XML file.

• <Database> identifies the database file into which parsed data should be 
saved.

• <AllowDuplicates> can be either True or False. When set to True, Data 
Parser will allow duplicate entries to be created from the parsed data. 
When set to False, Data Parser will discard duplicate entries.

• <RefreshInterval> specifies the number of seconds Data Parser waits 
before reloading the data source's URL.

• <TableStructure> defines the schema of the data table to be created from 
the parsed data. It requires a single attribute, Name, that specifies the 
name of the table. <TableStructure> contains child <Field> elements that 
define the columns of the table.\

The value of a field element is the name of the data table column. Each 
<Field> element requires a Type attribute specifying the column's type. 
Currently supported types are Text (a 255 character string), Memo (a 2048 
character string), and Integer. The <Field> element also allows optional 
AllowEmpty and KeyField attribute.

AllowEmpty can be either True or False, and determines whether Data 
Parser will accept table entries with no value for this column. The default 
for AllowEmpty is True.

The KeyField attribute can also be either True or False. When set to True, 
Data Parser will require unique values in this column for all the entries in 

NOTE: As data source definition files are XML code, care must be taken when 
using certain characters in parameter values. The characters in the table at the right 
must be replaced by their corresponding XML entity codes, or Data Parser will fail 
to load the data source definition file.
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the table, and will create an index for this column. The default for KeyField 
is False.

Regardless of the table structure schema, Data Parser always inserts two 
additional columns into the table:

— An ID column that contains a serial number for each row. Serial 
numbers start at 1 for the first row and are incremented by one for 
each additional row in the table.

— A Last Update column that contains the date and time the row was 
added to the table. This is generally the same value for all rows, unless 
Data Parser is creating a table with a particularly large number of rows 
or if the parsing work required for each row is quite long.

• An optional <PublishFile> element identifies an XML file which will 
contain a copy of the data table generated by this data source.

Here is a simple example of a <General> element. This example instructs Data 
Parser to parse the data feed at http://www.example.com/news.html every 
300 seconds, and to store the results in a file named Example.mdb, in a table 
named SampleTable with three Text columns: Headline, Reporter, and Date.

<General>

<Url>http://www.example.com/news.html</Url>

<Database>Example.mdb</Database>

<AllowDuplicates>True</AllowDuplicates>

<RefreshInterval>300</RefreshInterval>

<TableStructure>

<Field Type="Text">Headline</Field>
<Field Type="Text">Reporter</Field>

<Field Type="Text">Date</Field>

</TableStructure>
</General>

The ParsingRule Element
The <ParsingRule> element is the backbone of the data source definition. The 
purpose of this element is to extract text from a source, optionally manipulate 
the extracted text in some way, and place the result in a destination. It helps to 
think of sources and destinations as containers of text.

A <ParsingRule> element can contain other <ParsingRule> elements. Child 
<ParsingRule> elements are run after the parent rule.

The <ParsingRule> element has 3 required attributes:

• Type specifies the type of parsing rule to be used. See the Data Source 
Definition Reference Guide for a complete list of parsing rule types.
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• Result specifies the name of the container that should receive the output 
of the pasring rule. Ultimately, parsing rule results need to be placed into 
the data table fields defined in the <TableStructure> element, and so the 
names of the data table fields are valid values for the Result attribute. 
Other containers can also be created simply by naming them in a Result 
attribute. Any container named in a Result attribute, including data table 
fields, can be used as a Source in later <ParsingRule> elements.

If a Result attribute names an existing container, the container's contents 
are replaced with the output of the parsing rule.

• Source specifies the input text for the parsing rule. This can be either the 
original data feed or a container named in the Result attribute of a 
previous <ParsingRule> element. A special container named "Source" 
holds the original text obtained from the data source's URL. The contents 
of the "Source" container can be replaced by naming it in a Result attribute, 
just like any other container.

Definitions for all supported parsing rules are in the Parsing Rule Reference 
Guide at the end of this appendix.

Some parsing rules can work with an <Index> parameter. These are rules that 
extract a value from their Source container. The <Index> parameter identifies 
which occurrence of a value to extract. See the Reference Guide for more 
information relating to specific parsing rules. These "index-aware" rules are 
also used when processing <DataItem> elements (see below).

Some parsing rules support a special "tag" syntax for some or all of their 
parameters. These are identified as "taggable" in the Parsing Rule Reference 
Guide. The "tag" syntax provides two features:

•  Special character handling: The following string codes are replaced with 
specific character sequences:

—  <cr> is replaced with a carriage return character (ASCII code 13)

—  <lf> is replaced with a line feed character (ASCII code 10)

—  <crlf> is replaced with a carriage return (ASCII code 13) followed by 
a line feed (ASCII code 10). (This is the equivalent of using "<cr><lf>".)

—  <tab> is replaced with a tab character (ASCII code 9)

—  <space> is replaced with a space character (ASCII code 32)

• Container substitution: If a string between | characters is the name of an 
existing text container, the contents of the container replace the string and 
its | delimiters. For example, if a taggable parameter is "This is 
|SomeResult|" and there's a container named SomeResult that contains 
the text "awesome" then the parameter's value will be treated as "This is 
awesome".

Here are some simple examples of <ParsingRule> elements. The following 
parsing rule replaces all occurrences of "Football" in the original text of the 
data feed with "Baseball" and saves the result in a container named NewSport.
<ParsingRule Type="Replace" Source="Source" Result="NewSport">
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<SearchText>Football</SearchText>

<NewText>Baseball</NewText>

</ParsingRule>

The following parsing rule sets the value of the City container to "New York, 
NY".
<ParsingRule Type="SetValue" Result="City">

<Value>New York, NY</Value>

</ParsingRule>

The following parsing rule replaces all occurrences of "Vanilla" with 
"Chocolate" in the original text of the data feed. Note how the special "Source" 
container is being overwritten by this parsing rule - after running this rule, the 
special "Source" container will no longer contain the word "Vanilla".
<ParsingRule Type="Replace" Source="Source" Result="Source">

<SearchText>Vanilla</SearchText>

<NewText>Chocolate</NewText>

</ParsingRule>

The following parsing rule uses a taggable parameter to replace all 
occurrences of the two lines
Fred Flintstone

Barney Rubble

with the single word "Dino".
<ParsingRule Type="Replace" Source="Source" Result="Source">

<SearchText>Fred Flintstone<crlf>BarneyRubble</SearchText>

<NewText>Dino</NewText>

</ParsingRule>

The following parsing rule uses a taggable parameter to replace all 
occurrences of "Somebody" with the contents of the container called 
PersonName.
<ParsingRule Type="Replace" Source="Source" Result="Source">

<SearchText>Somebody</SearchText>

<NewText>|PersonName|</NewText>

</ParsingRule>

The DataItem Element
<DataItem> elements are used to repeatedly apply a list of parsing rules. This 
allows Data Parser to fill a table with multiple rows of data. For example, the 
headlines from a news feed could be inserted, one per row, in a table.

The <DataItem> element has two optional attributes:

Download from Www.Somanuals.com. All Manuals Search And Download.



Polycom Digital Signage Administrator Guide Data Source Definition File Overview

176 Polycom, Inc.

  

•  URL can be used to specify a new source that is only used for the parsing 
rules contained in the <DataItem> element. The URL is resolved and its 
contents are placed into the "Source" container before any of the 
DataItem's parsing rules are applied.

•  NumRecords specifies how many times to apply the DataItem's parsing 
rules. Any <ParsingRule> elements contained in a <DataItem> are applied 
in their order of appearance up to NumRecords times, or until an 
index-aware parsing rule returns an empty value.

Each time a DataItem's parsing rules are applied, the rules' Results are written 
into a new set of empty containers. A new row is added to the data table being 
created, and any parsing rule Results that identify a data table field are written 
to the new row.

Setting NumRecords to 0 (which is the default value) is the same as setting it 
to 999. 

Here is a simple example of a <DataItem> element that contains a single 
parsing rule. The following defines a table with a City column and adds 5 rows 
to that table, each containing the value "New York, NY".
<DataSource>

<General>

<RefreshInterval>…</RefreshInterval>

<AllowDuplicates>…</AllowDuplicates>

<Url>…</Url>

<Database>…</Database>

<TableStructure Name="SampleTable">

<Field Type="Text">City</Field>

</TableStructure>

</General>

<DataItem NumRecords="5">

<ParsingRule Type="SetValue" Result="City">

<Value>New York, NY</Value>

</ParsingRule>

</DataItem>

</DataSource>

Here how to use a <DataItem> element to parse the string "(x=1)(y=2)(z=3)". 
Assume we want to extract each equation's variable (x or y or z) and value (1 
or 2 or 3).
<DataItem>

<ParsingRule Type="GetTag" Source="Source" Result="Equation">

<StartTag>(</StartTag>

<EndTag>)</EndTag>

</ParsingRule>
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<ParsingRule Type="TrimFromStart" Source="Equation" 
Result="Variable">

<SearchText>=</SearchText>

</ParsingRule>

<ParsingRule Type="TrimToEnd" Source="Equation" Result="Value">

<SearchText>=</SearchText>

</ParsingRule>

</DataItem>

A <DataItem> element should contain one or more index-aware parsing rules. 
All of a DataItem's parsing rules are applied on each iteration. However, if a 
given DataItem parsing rule itself contains child rules, those child rules are not 
passed any index information for the current iteration. That is, child rules are 
never treated as index-aware. For an example of this, see the Data Source 
Tutorial below.

Data Source Tutorial
This section walks through the construction of a Data Source definition that 
extracts weather data from the U.S. National Weather Service web site.

This tutorial assumes the reader is familiar with HTML syntax.

NOTE:This tutorial was written using the U.S. Weather Service web site. The 
U.S. Weather Service may have changed their web site since writing, and so 
there is no guarantee that this tutorial will still work now. The tutorial is 
presented purely to illustrate Data Parser concepts.

In this tutorial we'll parse the weather data for New York City as obtained 
from the URL http://www.srh.noaa.gov/zipcity.php?inputstring=10005.
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General Settings
The general settings for the weather data source are straightforward. We tell 
Data Parser to refresh the feed every hour (i.e. 3600 seconds), to allow 
duplicate rows in the table, to fetch the feed from 
http://www.srh.noaa.gov/zipcity.php?inputstring=10005, and to store the 
parsed data in a table named Weather in the DataFeeds.mdb database:

   <General>
      <RefreshInterval>3600</RefreshInterval>

      <AllowDuplicates>True</AllowDuplicates>

      
<Url>http://www.srh.noaa.gov/zipcity.php?inputstring=10005<
/Url>

      <Database>DataFeeds.mdb</Database>

      <TableStructure Name="Weather">

         <Field Type="Text">DayPart</Field>

         <Field Type="Text">Condition</Field>

         <Field Type="Text">Temp</Field>

         <Field Type="Memo">ImageURL</Field>

         <Field Type="Memo">LocalImage</Field>

      </TableStructure>

   </General>

The Weather table we create has the following fields:

• DayPart: The part of the day that described by the weather data in the 
current row. For example, "Today" or "Friday Night".

• Condition: The weather conditions for the day part. For example, "Mostly 
Sunny" or "Partly Cloudy".

• Temp: The temperature for the day part. 

• ImageURL: The URL of the image used on the web site to depict the 
weather for the day part.

• LocalImage: The path and file name of a local copy of the image. We'll 
download the image as we parse the web page.

• Building the Data Source Definition

Resolving the URL (e.g. by opening it in a browser and viewing the source) 
gives us the following raw HTML code. This code contains a lot of extraneous 
information. The part we're interested in is the "Forecast at a Glance" section, 
which is highlighted in below.

<!doctype html public "-//W3C//DTD HTML 4.0 
Transitional//EN"><html><head>

<title>7-Day Forecast for Latitude 40.74N and Longitude 
-74.01W</title><link rel="STYLESHEET" type="text/css" 
href="fonts/main.css"></head><body leftmargin="0" 
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topmargin="0" rightmargin="0" marginwidth="0" 
marginheight="0" bgcolor="#FFFFFF" 
background="/images/wtf/gray_background.gif"><table 
cellspacing="0" cellpadding="0" border="0" width="670" 
background="/images/wtf/topbanner.jpg"><tr><td 
height="19">&nbsp;&nbsp;&nbsp;</td></tr></table><table 
cellspacing="0" cellpadding="0" border="0" width="670"><tr 
valign="top"><td rowspan="2"><a 
href="http://www.noaa.gov"><img 
src="/images/wtf/noaaleft.jpg" alt="NOAA logo - Click to go 
to the NOAA homepage" title="NOAA logo - Click to go to the 
NOAA homepage" width="85" height="78" 
border="0"></a></td><td height="20"><img 
src="/images/wtf/forecast_title.jpg" alt="Your National 
Weather Service forecast" title="Your National Weather 
Service forecast" width="500" height="20" 
border="0"></td><td rowspan="2" align="right"><a 
href="http://weather.gov"><img 
src="/images/wtf/nwsright.jpg" alt="NWS logo" title="NWS 
logo" width="85" height="78" border="0"></a></td></tr><tr 
align="center"><td 
background="/images/wtf/forecast_blank.jpg" height="57" 
class="white1">New York, NY<a href="#contents"><img 
src="/images/wtf/skipgraphic.gif" alt="Skip to Detailed 
7-Day Forecast" title="Skip to Detailed 7-Day Forecast" 
width="1" height="1" border="0"></a></td></tr></table><table 
cellspacing="0" cellpadding="0" border="0" 
background="/images/wtf/navbkgrnd.gif" 
width="670"><tr><td><img src="/images/wtf/navbarleft.jpg" 
alt="" width="94" height="23" border="0"></td><td 
align="left" class="searchinput"><form method="POST" 
action="http://forecast.weather.gov/zipcity.php" 
style="display:inline"><span class="yellow">Enter Your 
&quot;City, ST&quot; or zip code </span><span 
class="searchinput"><input type="text" name="inputstring" 
size="15" value=""></span>&nbsp;&nbsp; <INPUT TYPE="submit" 
NAME="Go2"

 VALUE="Go"></form></td></tr></table>

<table width="670" border="0" align="left">

<tr><td>

<table width="100%" border="0" align="center" 
cellpadding="0" cellspacing="0">

<tr>

<td align="left" valign="center"><a 
href=http://www.erh.noaa.gov/okx/>NWS New York City/Upton, 
NY</a><br><b>&nbsp;Point Forecast:</b> New York, 
NY<br>&nbsp;40.74N -74.01W</td><td align="right" 
valign="bottom"><a 
href="/MapClick.php?CityName=New+York&state=NY&site=OKX&tex
tField1=40.7198&textField2=-73.993&lg=sp"><b>En 
Espa&ntilde;ol</b></a><br><a 
href="http://www.weather.gov/glossary/index.php?word=Last+u
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pdate"><b>Last Update:</b></a> 8:38 am EDT Jul 5, 2007<br><a 
href="http://www.weather.gov/glossary/index.php?word=foreca
st+valid+for"><b>Forecast Valid:</b></a> 11am EDT Jul 5, 
2007-6pm EDT Jul 11, 2007</td>

</tr>

</table>

<table width="100%" border="0" align="center" 
cellpadding="0" cellspacing="0">

 <tr><td align="left"></td>

<td align="right"></td>

</tr>

<tr><td align="left" colspan="2">

<img alt="Forecast at a Glance" title="Forecast at a Glance" 
src="/images/wtf/7dayfcst.jpg">

</td>

</tr>

</table>

</td></tr>

<tr><td>

<table width="100%" border="0" align="center" 
cellpadding="0" cellspacing="0">

<tr valign ="top" align="center">

<td width="11%"><b>Today<br></b><br><img 
src="/images/wtf/tsra70.jpg" width="55" height="58" 
alt="Heavy Rain Chance for Measurable Precipitation 70%" 
title="Heavy Rain Chance for Measurable Precipitation 70%" 
><br>Heavy<br>Rain<br>Hi <font 
color="#FF0000">81&deg;F</font></td><td 
width="11%"><b>Tonight<br></b><br><img 
src="/images/wtf/ntsra80.jpg" width="55" height="58" 
alt="Heavy Rain Chance for Measurable Precipitation 80%" 
title="Heavy Rain Chance for Measurable Precipitation 80%" 
><br>Heavy<br>Rain<br>Lo <font 
color="#0033CC">69&deg;F</font></td><td 
width="11%"><b>Friday<br></b><br><img 
src="/images/wtf/hi_tsra20.jpg" width="55" height="58" 
alt="Slight Chance Thunderstorms Chance for Measurable 
Precipitation 20%" title="Slight Chance Thunderstorms Chance 
for Measurable Precipitation 20%" ><br>Slight 
Chc<br>Tstms<br>Hi <font 
color="#FF0000">85&deg;F</font></td><td 
width="11%"><b>Friday<br>Night</b><br><img 
src="/images/wtf/hi_ntsra20.jpg" width="55" height="58" 
alt="Slight Chance Thunderstorms Chance for Measurable 
Precipitation 20%" title="Slight Chance Thunderstorms Chance 
for Measurable Precipitation 20%" ><br>Slight 
Chc<br>Tstms<br>Lo <font 
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color="#0033CC">67&deg;F</font></td><td 
width="11%"><b>Saturday<br></b><br><img 
src="/images/wtf/few.jpg" width="55" height="58" alt="Mostly 
Sunny" title="Mostly Sunny" ><br>Mostly<br>Sunny<br>Hi <font 
color="#FF0000">86&deg;F</font></td><td 
width="11%"><b>Saturday<br>Night</b><br><img 
src="/images/wtf/nfew.jpg" width="55" height="58" 
alt="Mostly Clear" title="Mostly Clear" 
><br>Mostly<br>Clear<br>Lo <font 
color="#0033CC">69&deg;F</font></td><td 
width="11%"><b>Sunday<br></b><br><img 
src="/images/wtf/few.jpg" width="55" height="58" alt="Mostly 
Sunny" title="Mostly Sunny" ><br>Mostly<br>Sunny<br>Hi <font 
color="#FF0000">92&deg;F</font></td><td 
width="11%"><b>Sunday<br>Night</b><br><img 
src="/images/wtf/nsct.jpg" width="55" height="58" 
alt="Partly Cloudy" title="Partly Cloudy" 
><br>Partly<br>Cloudy<br>Lo <font 
color="#0033CC">75&deg;F</font></td><td 
width="11%"><b>Monday<br></b><br><img 
src="/images/wtf/sct.jpg" width="55" height="58" alt="Partly 
Cloudy" title="Partly Cloudy" ><br>Partly<br>Cloudy<br>Hi 
<font color="#FF0000">91&deg;F</font></td></tr>

</table>

<table width="100%" border="0" align="center" 
cellpadding="0" cellspacing="0">

<tr valign ="top">

<td valign="top" align="left" width="50%">

<br>

<img alt="Detailed text forecast" 
src="/images/wtf/fcst.jpg"><br><a name="contents"></a>

Hazardous weather condition(s):<br><div 
align="center"><br><a 
href="showsigwx.php?warnzone=NYZ072&warncounty=NYC061&firew
xzone=NYZ072&local_place1=New+York&product1=Hazardous+Weath
er+Outlook"><span class="warn">Hazardous Weather 
Outlook</span></a><br></div><br> 

<b>Today: </b>Showers and thunderstorms likely, mainly after 
noon. Some of the storms could produce gusty winds and heavy 
rain. Mostly cloudy, with a high near 81. Southwest wind 
between 8 and 10 mph.  Chance of precipitation is 70%. New 
rainfall amounts between a tenth and quarter of an inch, 
except higher amounts possible in thunderstorms. 
<br><br><b>Tonight: </b>Periods of showers and thunderstorms, 
mainly before 2am. Some of the storms could produce gusty 
winds and heavy rain. Low around 69. West wind between 7 and 
10 mph.  Chance of precipitation is 80%. New rainfall amounts 
between a quarter and half of an inch possible. 
<br><br><b>Friday: </b>A slight chance of showers and 
thunderstorms after noon.  Partly cloudy, with a high near 
85. West wind between 7 and 16 mph.  Chance of precipitation 

Download from Www.Somanuals.com. All Manuals Search And Download.



Polycom Digital Signage Administrator Guide Data Source Tutorial

182 Polycom, Inc.

  

is 20%.<br><br><b>Friday Night: </b>A slight chance of 
showers and thunderstorms before 10pm.  Partly cloudy, with 
a low around 67. Northwest wind between 6 and 13 mph.  Chance 
of precipitation is 20%.<br><br><b>Saturday: </b>Mostly 
sunny, with a high near 86. West wind between 8 and 16 mph. 
<br><br><b>Saturday Night: </b>Mostly clear, with a low 
around 69.  <br><br><b>Sunday: </b>Mostly sunny, with a high 
near 92.  <br><br><b>Sunday Night: </b>Partly cloudy, with a 
low around 75.  <br><br><b>Monday: </b>Partly cloudy, with a 
high near 91.  <br><br><b>Monday Night: </b>A chance of 
showers and thunderstorms.  Partly cloudy, with a low around 
73.   Chance of precipitation is 30%.<br><br><b>Tuesday: 
</b>A chance of showers and thunderstorms.  Partly cloudy, 
with a high near 88.   Chance of precipitation is 
30%.<br><br><b>Tuesday Night: </b>A chance of showers and 
thunderstorms.  Partly cloudy, with a low around 72.   Chance 
of precipitation is 30%.<br><br><b>Wednesday: </b>Partly 
cloudy, with a high near 89.  <br><br></td>

(We've omitted the rest of the HTML code, as it's not pertinent to this tutorial.)

Our first task is to isolate the part of the data that contains the information we 
want. First we remove everything before the "Forecast at a Glance" string using 
a TrimToEnd rule:
   <ParsingRule type="TrimToEnd" source="Source" 
result="Source">

      <SearchText>Forecast at a Glance</SearchText>

   </ParsingRule>

Note that this rule overwrites the Source container, which initially contains the 
entire HTML text.

Next we extract the contents of the first <table> element after the "Forecast at 
a Glance" text using a GetTag rule:
   <ParsingRule type="GetTag" source="Source" result="Source">

      <StartTag>&lt;table</StartTag>

      <EndTag>&lt;/table&gt;</EndTag>

   </ParsingRule>

Note how the < and > characters in the StartTag and EndTag parameters are 
replaced with XML character entity codes &lt; and &gt;.

The above two rules replace the full HTML code in the Source container with 
the following:
 width="100%" border="0" align="center" cellpadding="0" 
cellspacing="0">

<tr valign ="top" align="center">

<td width="11%"><b>Today<br></b><br><img 
src="/images/wtf/tsra70.jpg" width="55" height="58" alt="Heavy 
Rain Chance for Measurable Precipitation 70%" title="Heavy Rain 
Chance for Measurable Precipitation 70%" 
><br>Heavy<br>Rain<br>Hi <font 
color="#FF0000">81&deg;F</font></td><td 
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width="11%"><b>Tonight<br></b><br><img 
src="/images/wtf/ntsra80.jpg" width="55" height="58" alt="Heavy 
Rain Chance for Measurable Precipitation 80%" title="Heavy Rain 
Chance for Measurable Precipitation 80%" 
><br>Heavy<br>Rain<br>Lo <font 
color="#0033CC">69&deg;F</font></td><td 
width="11%"><b>Friday<br></b><br><img 
src="/images/wtf/hi_tsra20.jpg" width="55" height="58" 
alt="Slight Chance Thunderstorms Chance for Measurable 
Precipitation 20%" title="Slight Chance Thunderstorms Chance for 
Measurable Precipitation 20%" ><br>Slight Chc<br>Tstms<br>Hi 
<font color="#FF0000">85&deg;F</font></td><td 
width="11%"><b>Friday<br>Night</b><br><img 
src="/images/wtf/hi_ntsra20.jpg" width="55" height="58" 
alt="Slight Chance Thunderstorms Chance for Measurable 
Precipitation 20%" title="Slight Chance Thunderstorms Chance for 
Measurable Precipitation 20%" ><br>Slight Chc<br>Tstms<br>Lo 
<font color="#0033CC">67&deg;F</font></td><td 
width="11%"><b>Saturday<br></b><br><img 
src="/images/wtf/few.jpg" width="55" height="58" alt="Mostly 
Sunny" title="Mostly Sunny" ><br>Mostly<br>Sunny<br>Hi <font 
color="#FF0000">86&deg;F</font></td><td 
width="11%"><b>Saturday<br>Night</b><br><img 
src="/images/wtf/nfew.jpg" width="55" height="58" alt="Mostly 
Clear" title="Mostly Clear" ><br>Mostly<br>Clear<br>Lo <font 
color="#0033CC">69&deg;F</font></td><td 
width="11%"><b>Sunday<br></b><br><img src="/images/wtf/few.jpg" 
width="55" height="58" alt="Mostly Sunny" title="Mostly Sunny" 
><br>Mostly<br>Sunny<br>Hi <font 
color="#FF0000">92&deg;F</font></td><td 
width="11%"><b>Sunday<br>Night</b><br><img 
src="/images/wtf/nsct.jpg" width="55" height="58" alt="Partly 
Cloudy" title="Partly Cloudy" ><br>Partly<br>Cloudy<br>Lo <font 
color="#0033CC">75&deg;F</font></td><td 
width="11%"><b>Monday<br></b><br><img src="/images/wtf/sct.jpg" 
width="55" height="58" alt="Partly Cloudy" title="Partly Cloudy" 
><br>Partly<br>Cloudy<br>Hi <font 
color="#FF0000">91&deg;F</font></td></tr>

This is a single HTML table row that contains all the weather data we need. 
Before we extract that data, we use the ReplaceCharacterCodes rule to replace 
all HTML character codes (e.g. &deg;) with their true characters (e.g. the 
degree symbol °):
<ParsingRule type="ReplaceCharacterCodes" source="Source" 
result="Source" />

Now that the text characters are in order, we want to set about extracting each 
day part's forecast. We use a DataItem element to apply a set of parsing rules 
9 times, once for each day part in the HTML code:
<DataItem NumRecords="9" ClearTableOnStart="True">

…

</DataItem>
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All of the remaining parsing rules in this tutorial are contained in this 
DataItem element.

In the HTML we've isolated, each cell of the table row contains the forecast for 
a day part. For example, the cell contains the forecast for "Today" (we've 
reformatted the code below to make it easier to see the forecast data):
<td width="11%">

<b>Today<br></b>

<br>

<imgsrc="/images/wtf/tsra70.jpg"

width="55" height="58"

alt="Heavy Rain Chance for Measurable Precipitation 70%"

title="Heavy Rain Chance for Measurable Precipitation 70%" >

<br>

Heavy<br>Rain

<br>

Hi <font color="#FF0000">81°F</font>

</td>

Each cell contains the day part's name (e.g. "Today"), the conditions (as the 
image's alternative text, e.g. "Heavy Rain Chance for Measurable Precipitation 
70%"), the temperature (e.g. "81°F") and an image file (e.g. 
"/images/wtf/tsra70.jpg"). We'll extract each of these pieces of information in 
turn.

First, we need to isolate a given day part's table cell. We do this using a GetTag 
rule to isolate the text between the <td> and </td> tags:
<ParsingRule type="GetTag" Source="Source" result="DaySource">

<StartTag>&lt;td </StartTag>

<EndTag>&lt;/td&gt;</EndTag>

</ParsingRule>

The GetTag rule is index-aware, so because it is inside a <DataItem> element 
it will extract each table cell in turn. We used the <DataItem> element to apply 
its rules 9 times, so this GetTag rule will extract each of the 9 table cells. On the 
first iteration, the rule extracts the contents of the first table cell:
 width="11%"><b>Today<br></b><br><img 
src="/images/wtf/tsra70.jpg" width="55" height="58" alt="Heavy 
Rain Chance for Measurable Precipitation 70%" title="Heavy Rain 
Chance for Measurable Precipitation 70%" 
><br>Heavy<br>Rain<br>Hi <font color="#FF0000">81°F</font>

On the second iteration, the rule extracts the contents of the second table cell:
 width="11%"><b>Tonight<br></b><br><img 
src="/images/wtf/ntsra80.jpg" width="55" height="58" alt="Heavy 
Rain Chance for Measurable Precipitation 80%" title="Heavy Rain 
Chance for Measurable Precipitation 80%" 
><br>Heavy<br>Rain<br>Lo <font color="#0033CC">69°F</font>

And so on for each of the 9 iterations.
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Now that we've isolated the weather data for a single day part, we can extract 
that data and save it in a row of our table. First we obtain the name of the day 
part using a GetTag rule to extract the text the lies between the <b> and </b> 
tags in the DaySource container:
<ParsingRule type="GetTag" source="DaySource" result="DayPart">

<StartTag>&lt;b&gt;</StartTag>

<EndTag>&lt;/b&gt;</EndTag>

</ParsingRule>

There's a subtle problem here. What we want is to extract the text from 
between the first (indeed, the only) pair of <b> and </b> tags. However, 
simply adding the above rule to the <DataItem> element will not work:
<DataItem NumRecords="9" ClearTableOnStart="True">

<ParsingRule type="GetTag" Source="Source" result="DaySource">

<StartTag>&lt;td </StartTag>

<EndTag>&lt;/td&gt;</EndTag>

</ParsingRule>

<ParsingRule type="GetTag" source="DaySource" result="DayPart">

<StartTag>&lt;b&gt;</StartTag>

<EndTag>&lt;/b&gt;</EndTag>

</ParsingRule>

</DataItem>

The above code will only extract the first day part's name, but will not extract 
anything for subsequent day parts. To understand why, recall that the GetTag 
rule is index-aware. This means that on each iteration of the DataItem's rules, 
GetTag is trying to obtain that iteration's occurrence of the StartTag and 
EndTag values. So on the first iteration, the second GetTag rule retrieves the 
text between first occurrence of <b> and </b>. But on the second iteration that 
rule tries to retrieve the text between the second occurrence of <b> and </b>. 
Since there is no second occurrence of <b> and </b> in the DaySource 
container the rule retrieves nothing.

To achieve what we want, the second rule has to be made a child of the first 
rule:
<DataItem NumRecords="9" ClearTableOnStart="True">

<ParsingRule type="GetTag" Source="Source" result="DaySource">

<StartTag>&lt;td </StartTag>

<EndTag>&lt;/td&gt;</EndTag>

<ParsingRule type="GetTag" source="DaySource" result="DayPart">

<StartTag>&lt;b&gt;</StartTag>

<EndTag>&lt;/b&gt;</EndTag>

</ParsingRule>
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</ParsingRule>

</DataItem>

This changes the way Data Parse handles the second rule. Because it is a now 
child rule, the current DataItem iteration is not passed to it as an Index value. 
This makes the rule use the default index value (1), and so it now always 
retrieves the text between the first occurrence of <b> and </b>.
A different way we could have solved this problem would be to 
instead add an Index parameter to the second GetTag rule so that 
it always extracts from the first occurrence:

<DataItem NumRecords="9" ClearTableOnStart="True">

<ParsingRule type="GetTag" Source="Source" result="DaySource">

<StartTag>&lt;td </StartTag>

<EndTag>&lt;/td&gt;</EndTag>

</ParsingRule>

<ParsingRule type="GetTag" source="DaySource" result="DayPart">

<StartTag>&lt;b&gt;</StartTag>

<EndTag>&lt;/b&gt;</EndTag>

<Index>1</Index>

</ParsingRule>

</DataItem>

However, using child rules is preferred because it's easy to forget to include 
that Index parameter.

Let's return to the tutorial. Now that we have the day part name, but if you 
look carefully at what's between the <b> and </b> tags you'll see that the day 
part name always has a "<br>" string. Sometimes it's just at the end of the 
string, as in "Friday<br>", and other times it's in the middle, as in 
"Friday<br>Night". Let's replace that "<br>" with a space:
<ParsingRule type="Replace" source="DayPart" result="DayPart">

<SearchText>&lt;br&gt;</SearchText>

<NewText>&lt;space&gt;</NewText>

</ParsingRule>

Note the use of "<space>" (with the < and > substituted by entity codes) as the 
NewText parameter. We have to use the <space> token because XML strips 
spaces from values. If we had simple used a space character, as in <NewText> 
</NewText>, we would actually be removing the SearchText instead of 
replacing it with a space. This would result in translating day part names like 
"Friday<br>Night" to "FridayNight" instead of "Friday Night".

With the day part name safely in the DayPart field of the table, let's extract the 
weather conditions. For this, we want part of the phrase that's used as the title 
attribute of the <img> element (such as title="Heavy Rain Chance for 
Measurable Precipitation 70%"). We only want the "Heavy Rain" part, so we 
want to drop the "Chance for …" text.
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First we need to extract the value of the title attribute using another GetTag 
rule (which, again, is inserted as a child of the first rule) that extracts the text 
between "title="" (including the opening quote character) and the closing 
quote character:
<ParsingRule type="GetTag" source="DaySource" 
result="Condition">

<StartTag>title=&quot;</StartTag>

<EndTag>&quot;</EndTag>

</ParsingRule>

Then we remove the "Chance for" string, and any text that follows 
it, using the TrimFromStart rule:

<ParsingRule type="TrimFromStart" source="Condition" 
result="Condition">

<SearchText>Chance for</SearchText>

</ParsingRule>

This leaves us with the desired text, but with a trailing space character (e.g. 
"Heavy Rain "). We remove this extra space with a Trim rule:
<ParsingRule type="Trim" source="Condition" result="Condition" 
/>

Why didn't we just use a <space> token in the SearchText parameter of the 
TrimFromStart rule (e.g. <SearchText>&lt;space&gt;Chance 
for</SearchText>)? Because TrimFromStart's SearchText parameter does not 
support the special "tag" syntax, so it doesn't interpret the <space> token as a 
space character.

Now let's turn to the temperature. In each table cell, the temperature string is 
always found between a <br> tag and a closing </font> tag (e.g. <br>Hi <font 
color="#FF0000">81°F</font>). So we use those tags in a GetTag rule to 
extract the temperature:
<ParsingRule type="GetTag" source="DaySource" result="Temp">

<StartTag>&lt;br&gt;</StartTag>

<EndTag>&lt;/font&gt;</EndTag>

</ParsingRule>

This gets us the temperature, but with the string "<font color="#FF0000">" 
embedded inside. We want to keep the "Hi" or "Lo" part, so we just want to 
remove that opening <font …> element. If you look at the HTML code, you'll 
see that "Hi" temperatures get a font color of #FF0000 while "Lo" temperatures 
get #0033CC. Since we want to remove the font tag regardless of what color is 
specified, we use a ReplaceTag rule to remove everything from the "<font" to 
the ">":
<ParsingRule type="ReplaceTag" source="Temp" result="Temp">

<StartTag>&lt;font</StartTag>

<EndTag>&gt;</EndTag>

<NewText/>

</ParsingRule>
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Finally, let's extract the day part's weather image URL and download the 
image file so that it's available on the local machine. The image URL is made 
up of the web site address (http://www.erh.noaa.gov) concatenated with the 
value of the HTML <img> element's src attribute. First, we extract the value of 
the src attribute with a GetTag rule:
<ParsingRule type="GetTag" source="DaySource" 
result="ImageURL">

<StartTag>img src=&quot;</StartTag>

<EndTag>&quot;</EndTag>

</ParsingRule>

Then we use a StrCat rule to prepend the web site's address to form the 
complete URL:
<ParsingRule type="StrCat" result="ImageURL">

<String1>http://www.erh.noaa.gov</String1>

<String2>|ImageURL|</String2>

<AddSpace>False</AddSpace>

</ParsingRule>

StrCat's String1 and String2 parameters are taggable, so we use the special 
|ImageURL| syntax to specify the contents of the ImageURL container as the 
value for String2. These preceding two rules give us a full URL for the image 
(e.g. http://www.erh.noaa.gov/images/wtf/tsra70.jpg).

We can now download the image file. First we obtain the image's file name 
with a GetTag rule that extracts strings that lie between a "/" and ".jpg":
<ParsingRule type="GetTag" source="ImageURL" 
result="LocalImage">

<StartTag>/</StartTag>

<EndTag>.jpg</EndTag>

</ParsingRule>

This extracts "tsra70" from the ImageURL container. This seems 
counter-intuitive: Why didn't the GetTag rule instead extract 
"/www.erh.noaa.gov/images/wtf/tsra70" (i.e. everything between the first 
"/" and ",jpg")? The answer lies in how GetTag handles nested tags. GetTag 
always returns the innermost instance. For example, if the source string were 
"Mary had a <<li<<tt>>le>> lamb" and the StartTag were "<<" and the EndTag 
were ">>", then GetTag would return "tt".

What this means in our case is that when GetTag notices that the StartTag ("/") 
still shows up in the string following its first occurrence, GetTag will move 
forward through the string until the StartTag no longer appears. Thus for 
"http://www.erh.noaa.gov/images/wtf/tsra70.jpg" GetTag analyses the 
following strings:
http://www.erh.noaa.gov/images/wtf/tsra70.jpg

/www.erh.noaa.gov/images/wtf/tsra70.jpg

/images/wtf/tsra70.jpg

/wtf/tsra70.jpg
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/tsra70.jpg

Only when GetTag reaches that last string does it assume its found the 
innermost StartTag, and so then it returns whatever lies between the StartTag 
and the EndTag.

With the (extensionless) image file name in hand we can now construct a local 
path for the image file, and restore the file's extension, using a couple of StrCat 
rules. Let's store the downloaded images in the C:\NOAAImages\ directory:
<ParsingRule type="StrCat" source="" result="LocalImage">

<String1>C:\NOAAImages\</String1>

<String2>|LocalImage|</String2>

</ParsingRule>

<ParsingRule type="StrCat" source="" result="LocalImage">

<String1>|LocalImage|</String1>

<String2>.jpg</String2>

</ParsingRule>

With the image file's local name set in the LocalImage container we can now 
use GetImage to download the file:
<ParsingRule type="GetImage" source="" result="">

<Url>|ImageURL|</Url>

<LocalFilename>|LocalImage|</LocalFilename>

</ParsingRule>

This rule downloads the file at the URL stored in the ImageURL container and 
saves it in the file named in the LocalImage container.

This completes the tutorial. The final definition file is shown below.
<DataSource>

<General>

<RefreshInterval>3600</RefreshInterval>

<AllowDuplicates>True</AllowDuplicates>

<Url>http://www.srh.noaa.gov/zipcity.php?inputstring=10005<
/Url>

<Database>DataFeeds.mdb</Database>

<TableStructure Name="Weather">

<Field Type="Text">DayPart</Field>

<Field Type="Text">Condition</Field>

<Field Type="Text">Temp</Field>

<Field Type="Memo">ImageURL</Field>

<Field Type="Memo">LocalImage</Field>

</TableStructure>

</General>
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<ParsingRule type="TrimToEnd" source="Source" 
result="Source">

<SearchText>Forecast at a Glance</SearchText>

</ParsingRule>

<ParsingRule type="GetTag" source="Source" result="Source">

<StartTag>&lt;table</StartTag>

<EndTag>&lt;/table&gt;</EndTag>

</ParsingRule>

<ParsingRuletype="ReplaceCharacterCodes"

source="Source"

result="Source" />

<DataItem NumRecords="9" ClearTableOnStart="True">

<ParsingRule type="GetTag" Source="Source" 
result="DaySource">

<StartTag>&lt;td </StartTag>

<EndTag>&lt;/td&gt;</EndTag>

<ParsingRule type="GetTag" source="DaySource" 
result="DayPart">

<StartTag>&lt;b&gt;</StartTag>

<EndTag>&lt;/b&gt;</EndTag>

</ParsingRule>

<ParsingRule type="Replace" source="DayPart" 
result="DayPart">

<SearchText>&lt;br&gt;</SearchText>

<NewText>&lt;space&gt;</NewText>

</ParsingRule>

<ParsingRule type="GetTag" source="DaySource" 
result="Condition">

<StartTag>title=&quot;</StartTag>

<EndTag>&quot;</EndTag>

</ParsingRule>

<ParsingRuletype="TrimFromStart"

source="Condition"

result="Condition">

<SearchText>Chance for</SearchText>

</ParsingRule>

<ParsingRule type="Trim" source="Condition" 
result="Condition" />

<ParsingRule type="GetTag" source="DaySource" result="Temp">

<StartTag>&lt;br&gt;</StartTag>
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<EndTag>&lt;/font&gt;</EndTag>

</ParsingRule>

<ParsingRule type="ReplaceTag" source="Temp" result="Temp">

<StartTag>&lt;font</StartTag>

<EndTag>&gt;</EndTag>

<NewText/>

</ParsingRule>

<ParsingRule type="GetTag" source="DaySource" 
result="ImageURL">

<StartTag>img src=&quot;</StartTag>

<EndTag>&quot;</EndTag>

</ParsingRule>

<ParsingRule type="StrCat" result="ImageURL">

<String1>http://www.erh.noaa.gov</String1>

<String2>|ImageURL|</String2>

<AddSpace>False</AddSpace>

</ParsingRule>

<ParsingRule type="GetTag" source="ImageURL" 
result="LocalImage">

<StartTag>/</StartTag>

<EndTag>.jpg</EndTag>

</ParsingRule>

<ParsingRule type="StrCat" source="" result="LocalImage">

<String1>C:\NOAAImages\</String1>

<String2>|LocalImage|</String2>

</ParsingRule>

<ParsingRule type="StrCat" source="" result="LocalImage">

<String1>|LocalImage|</String1>

<String2>.jpg</String2>

</ParsingRule>

<ParsingRule type="GetImage" source="" result="">

<Url>|ImageURL|</Url>

<LocalFilename>|LocalImage|</LocalFilename>

</ParsingRule>

</ParsingRule>

</DataItem>

</DataSource>
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Parsing Rule Reference Guide
This section describes all the parsing rules you can use with Data Parser.

GetImage
The GetImage rule downloads a file (not just image files) from a URL to a local 
file.

The Source and Result attributes are required, but ignored.

Parameters:

•  Url (taggable): The URL for the file to download.

•  LocalFilename (taggable): The path and name to save the file as.

Example:

The following rule downloads the file home_main_polycom.jpg from 
www.polycom.com and saves it as C:\polycom_banner.jpg.

<ParsingRule Type="GetImage" Source="" Result="">
<Url>http://www.polycom.com/images/home_main_polycom.jpg</Url>

<LocalFilename>C:\polycom_banner.jpg</LocalFilename>

</ParsingRule>

GetTag
The GetTag rule extracts text from between a pair of strings.

Parameters:

•  StartTag (taggable): The starting delimiter of the text to extract.

•  EndTag (taggable): The ending delimiter of the text to extract.

•  Index (optional): Which occurrence of the text to extract.

Examples:

The following rule extracts whatever text lies between the first occurrence of 
"here" and "there".

<ParsingRule Type="GetTag" Source="Source" Result="Replaced">
<StartTag>here</StartTag>

<EndTag>there</EndTag>

</ParsingRule>
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The following rule extracts whatever text lies between the fifth occurrence of 
"here" and "there".
<ParsingRule Type="GetTag" Source="Source" Result="Replaced">

<StartTag>here</StartTag>

<EndTag>there</EndTag>

<Index>5</Index>

</ParsingRule>

GetUrl
The GetUrl rule downloads a file from a URL into the Result container.

The Source attribute is required, but ignored.

Parameters:

 Url (taggable): The URL to download.

Example:

The following rule downloads the index.asp file from www.polycom.com and 
places its contents in the polycomHome container.
<ParsingRule Type="GetUrl" Source="" Result="polycomHome">

<Url>http://www.polycom.com/index.asp</Url>

</ParsingRule>

InitCaps
The InitCaps rule converts to uppercase the first letter of every word in the 
Source container.

Parameters: None.

Example:

<ParsingRule Type="InitCaps" Source="SomeSource" Result="Capitalized" 
/>

Lcase
The Lcase rule converts to lowercase all the letters in the Source container.

Parameters: None
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Example:

<ParsingRule Type="Lcase" Source="SomeSource" Result="AllSmallLetters" 
/>

Left
The Left rule extracts a specified number of characters from the beginning of 
the Source container.

Parameters:

•  Length: The number of characters to extract from the beginning of the 
Source container.

Example:

If the LongString container contains "abcdefghijklmnopqrstuvwxyz" then the 
following rule will place "abcde" in the ShortStuff container.

<ParsingRule Type="Left" Source="LongString" 
Result="ShortStuff">

<Length>5</Length>

</ParsingRule>

LeftTrim
The LeftTrim rule removes a specified number of characters from the 
beginning of the Source container.

Parameters:

•  Length: The number of characters to remove from the beginning of the 
Source container.

Example:

If the LongString container contains "abcdefghijklmnopqrstuvwxyz" then the 
following rule will place "fghijklmnopqrstuvwxyz" in the ShortStuff container.
<ParsingRule Type="LeftTrim" Source="LongString" 
Result="ShortStuff">

<Length>5</Length>

</ParsingRule>
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Mid
The Mid rule extracts a string of a specified length from a specified starting 
character in the Source container.

Parameters:

•  Length: The number of characters to extract.

•  Start: The character position in the Source container from which to extract 
the characters.

Example:

If the LongString container contains "abcdefghijklmnopqrstuvwxyz" then the 
following rule will place "efghijklmn" in the ShortStuff container.
<ParsingRule Type="Mid" Source="LongString" 
Result="ShortStuff">

<Length>10</Length>

<Start>5</Start>

</ParsingRule>

ParseDelimited
The ParseDelimited rule extracts a specific substring from a delimited string. 
A delimited string is a string made up of substring separated by a delimiting 
character. For example: "this,is,a,comma,delimited,string".

This rule is useful in parsing comma-separated-value files.

Parameters:

•  Delimiter: The delimiting character used to separate substrings.

•  Index (optional): Which substring to extract.

Example:

If the BigString container contains "this=is=a=short=string" then the following 
rule places "short" in the Token container.
<ParsingRule Type="ParseDelimited" Source="BigString" 
Result="Token">

<Delimiter>=</Delimiter>

<Index>4</Index>

</ParsingRule>
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ReadTextFile
The ReadTextFile rule loads the contents of a text file into the Result container.

The Source attribute is required, but ignored.

Parameters:

•  Filename: The path and name of the file to load.

Example:

The following rule loads the contents of the C:\Test.txt file into the Tester 
container.
<ParsingRule Type="ReadTextFile" Source="" Result="Tester">

<Filename>C:\Test.txt</Filename>

</ParsingRule>

Replace
The Replace rule replaces the all occurrences of a string of text with another 
string of text.

Parameters:

•  SearchText: The string to be replaced.

•  NewText: The string to substitute in place of the SearchText string.

Examples:

The following rule replaces all occurrences of "Goofy" in the Characters 
container with "Pluto".
<ParsingRule Type="Replace" Source="Characters" 
Result="NoGoofy">

<SearchText>Goofy</SearchText>

<NewText>Pluto</NewText>

</ParsingRule>

The following rule removes all occurrences of "stars" in the Galaxy container.
<ParsingRule Type="Replace" Source="Galaxy" Result="DarkMatter">
<SearchText>stars</SearchText>
<NewText></NewText>
</ParsingRule>
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ReplaceCharacterCodes
The ReplaceCharacterCodes rule replaces all occurrences of various HTML 
character codes with their true characters.

Parameters: None

Example:
<ParsingRuleType="ReplaceCharacterCodes"
Source="SomeSource"
Result="Capitalized" />

ReplaceTag
The ReplaceTag rule replaces the text that occurs between a pair of strings.

Parameters:

•  StartTag (taggable): The starting delimiter of the text to replace.

•  EndTag (taggable): The ending delimiter of the text to replace.

•  NewText (taggable): The replacement text.

•  Index (optional): Which occurrence of the delimited text to replace.

Example:

If the BigString container contains "A or B or C or D" then the following rule 
places "A or B or baseball or D" into the Chuckle container.
<ParsingRule Type="ReplaceTag" Source="BigString" Result="Chuckle">
<StartTag>or</StartTag>
<EndTag>or</EndTag>
<NewText> baseball </NewText>
<Index>2</Index>
</ParsingRule>

Right
The Right rule extracts a specified number of characters from the end of the 
Source container.

Parameters:

•  Length: The number of characters to extract from the end of the Source 
container.
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Example:

If the LongString container contains "abcdefghijklmnopqrstuvwxyz" then the 
following rule will place "vwxyz" in the ShortStuff container.
<ParsingRule Type="Right" Source="LongString" Result="ShortStuff">
<Length>5</Length>
</ParsingRule>

RightTrim
The RightTrim rule removes a specified number of characters from the end of 
the Source container.

Parameters:

•  Length: The number of characters to remove from the end of the Source 
container.

Example:

If the LongString container contains "abcdefghijklmnopqrstuvwxyz" then the 
following rule will place "abcdefghijklmnopqrstu" in the ShortStuff container.
<ParsingRule Type="RightTrim" Source="LongString" Result="ShortStuff">
<Length>5</Length>
</ParsingRule>

SetValue
The SetValue rule places a literal string directly into the Result container.

The Source attribute is required, but ignored.

Parameters:

•  Value (taggable): The value to return.

Examples:

The following rule places "twinkle" into the Eye container.
<ParsingRule Type="SetValue" Source="" Result="Eye">
<Value>twinkle</Value>
</ParsingRule>

If the Tear container contains "drop" then the following rule places "drop" in 
the Eye container.
<ParsingRule Type="SetValue" Source="" Result="Eye">
<Value>|Tear|</Value>
</ParsingRule>
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StrCat
The StrCat rule concatenates two strings, optionally adding a space between 
them.

The Source attribute is required, but ignored.

Parameters:

•  String1 (taggable): The string that will be the start of the result.

•  String2 (taggable): The string that will be the end of the result.

•  AddSpace (optional): If set to TRUE, a space is inserted between the 
String1 and String2.

Examples:

The following rule places "eatcake" into the Food container.
<ParsingRule Type="StrCat" Source="" Result="Food">
<String1>eat</String1>
<String1>cake</String1>
</ParsingRule>

The following rule places "eat cake" into the Food container.
<ParsingRule Type="StrCat" Source="" Result="Food">
<String1>eat</String1>
<String1>cake</String1>
<AddSpace>true</AddSpace>
</ParsingRule>

If the Snack container contains "pizza" then the following rule places "eat 
pizza" into the Food container.
<ParsingRule Type="StrCat" Source="" Result="Food">
<String1>eat</String1>
<String1>|Snack|</String1>
<AddSpace>true</AddSpace>
</ParsingRule>

Trim
The Trim rule removes any leading and trailing spaces from the Source 
container.

Parameters: None.

Example:

If the LotsOfSpace container contains "    hello     " then the following rule places 
"hello" (without any leading or trailing spaces) in the LeanAndMean 
container.
<ParsingRule Type="Trim" Source="LotsOfSpace" Result="LeanAndMean" />
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TrimFromEnd, TrimFromStart, TrimToEnd and TromToStart
These four rules all remove some text from the source container. They all take 
the same parameter, SearchText. The rules differ in whether they trim the 
beginning or end of a string, and whether or not they include the SearchText 
value in the result.

Parameters:

•  SearchText: The first occurrence of this string will form the basis of the 
trimming.

Examples:

Suppose the Source container contains "Mary had a little lamb". The following 
rule places " little lamb" (note the leading space!) in the MaryStuff container.
<ParsingRule Type="TrimToEnd" Source="Source" Result="MaryStuff">
<SearchText>had a</SearchText>
</ParsingRule>

The following rule places "ry had a little lamb" (everything after the first "a") 
in the MaryStuff container.
<ParsingRule Type="TrimToEnd" Source="Source" Result="MaryStuff">
<SearchText>a</SearchText>
</ParsingRule>

The following rule places "Mary " (note the trailing space!) in the MaryStuff 
container.
<ParsingRule Type="TrimFromStart" Source="Source" Result="MaryStuff">
<SearchText>had a</SearchText>
</ParsingRule>

The following rule places "M" (everything before the first "a") in the MaryStuff 
container.
<ParsingRule Type="TrimFromStart" Source="Source" Result="MaryStuff">
<SearchText>a</SearchText>
</ParsingRule>

Ucase
The Ucase rule converts to uppercase all the letters in the Source container.

Parameters: None

Example:
<ParsingRule Type="Ucase" Source="SomeSource" Result="AllBigLetters" 
/>
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C
Appendix C: Configuration Files

This appendix outlines the procedure to change PDS Player settings via the 
Remote Manager. Please note that this appendix is intended only for 
sophisticated users. Contact Polycom Support before changing any 
configuration files.

Changing Output Settings with the XPT.ini Configuration File
All Player Configuration Files are managed through the PDS Remote 
Manager. 

To access and edit the PDS Player Configuration Files:

1 Launch Remote Manager.

2 Double-click on a Player in the Connections tab to launch the Remote 
Player Management Console.

NOTE: Please contact Polycom Support before making changes to the 
configuration files.
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3 Click Edit Config in the Remote Player Management Console toolbar. A 
drop-down menu will appear.
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4 Choose XPT.ini. The file editor will launch.

5 To change the output resolution of the target player or players:

a Scroll to [Output Settings].

b If your Player uses one of the standard resolutions, enter a value for 
StandardOutputDims. Please note that this value corresponds to the 
order of appearance in the drop-down menu in the Player Settings.

Consequently, the following values apply at time of writing:

» StandardOutputDims=0: 640x480 resolution.
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» StandardOutputDims=1: 720x480 resolution.

» StandardOutputDims=2: 720x486 resolution.

» StandardOutputDims=3: 720x576 resolution.

» StandardOutputDims=4: 800x600 resolution.

» StandardOutputDims=5: 1024x768 resolution.

» StandardOutputDims=6: 1280x720 resolution.

» StandardOutputDims=7: 1280x1024 resolution.

» StandardOutputDims=8: 1600x1200 resolution.

» StandardOutputDims=9: 1920x1080 resolution.

6 To set your Player output to Full Screen Mode:

a Scroll to [Settings].

b Ensure that FullScreen=True.

7 To change your Player output orientation:

a Scroll to [Output Settings].

b For the default horizontal (i.e., 1024x768) output, set 
OutputMode=Landscape.

c For vertical (i.e., 768x1024) output, set OutputMode=Portrait.

8 To enable Dual Monitor Mode:

a Scroll to [Settings].

b Set DualMonitor=True.

c To disable Dual Monitor Mode, set DualMonitor=False.

9 To enable Full Screen Mode:

a Scroll to [Settings].

b Set FullScreen=True.

c To disable Full Screen Mode, set FullScreen=False.

10 To automatically resize the output for the monitor:

a Scroll to [Output Settings].

b Set AutoResizeOutput=True.

c To disable, set AutoResizeOutput=False.

11 When complete, click Save to Players.

NOTE: All other elements of the XPT.ini file should not need to be user-configured. 
Contact Polycom Support before making changes to any element not detailed 
above.
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12 In the Select Target Players dialog that appears, indicate to which Players 
you wish to save the changed configuration file. Click OK.

13 The Request window will appear. The file will update and the 
configuration changes should apply.

14 If configuration changes do not apply immediately, enter RESTART in the 
Command space of the Remote Player Management Console. The Player 
will restart and the changes will have been applied.
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